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About This Book

Welcome to Palm™ Desktop software. This guide describes all you need to know 
about how to use Palm Desktop software with your handheld. It walks you 
through using the features of the four modules in the application, working with 
lists, finding information, printing from the application, and transferring data 
between Palm Desktop software and your handheld.

This guide is designed to help you get up and running quickly with Palm Desktop 
software. The first chapter introduces the application. The second chapter contains 
a tutorial that exercises the features of Palm Desktop software.

After you become familiar with the basic functionality, you can use the rest of this 
guide as a reference for less common tasks, and also as a source of information if 
you have problems operating Palm Desktop software. 

In addition to this guide, Palm Desktop software contains online help that is 
available from the main menu bar and from the help button in dialog boxes. See 
online help for more detailed information about a function or task.
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CHAPTER 1

Introducing Palm™ Desktop Software

This chapter gets you started with Palm™ Desktop software and introduces you to 
some of its features.

About the modules
Palm Desktop software has four modules: Address Book, Date Book, Memo Pad, 
and To Do List. You can add information to any module at any time. You can also 
connect, or attach, any record to any other, so you can jump right to the information 
you need.

The information from each of these modules is synchronized with the information 
in the basic applications on your handheld when you perform a HotSync® 
operation.

Address Book
The Address Book module keeps track of names, addresses, company information, 
telephone numbers, birthdays, e-mail addresses, web sites, and so on. You can 
attach any record to an address card. For example, you can create a To Do List item 
to call a client and attach this item to the client’s address card so that all the 
information you need is available for the phone call. 
3
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Example
To remind yourself to call a friend next week, create a To Do List item. Palm™ 
Desktop software automatically finds the address records that seem related to this 
To Do List item. For example, if you write “Call Jodie,” it will find all addresses 
containing the name “Jodie.” If you attach one of the addresses to the To Do List 
item, a paper clip pop-up menu icon  appears next to the To Do List Item. You 
can click the paper clip pop-up menu to open your friend’s address card.

Date Book
The Date Book module manages your appointments and events. You can choose 
among three views:

■ Day

■ Week

■ Month

Day view

Month view

Week view
4



About the modules
You can attach any record to a Date Book event. For example, you can attach a 
client’s address card to an event so that you can quickly jump to this information 
if you need it.

You can set events to appear once, or repeat over an interval you set. You can create 
events to show special days, such as anniversaries, birthdays, and vacations. An 
event can span one day or several.

Example
You created an event for an upcoming meeting. You can specify how far in advance 
of the meeting you want an onscreen alarm reminder to display. (Palm Desktop 
software does not need to be running for this alarm reminder to display.) For 
regularly scheduled meetings you can create a repeating event, so you need only 
type the item once. The rest of the events are created based on the repeat interval 
you specify.

Memo Pad
Create memos during telephone calls, meetings, or whenever you need to create a 
memo for yourself. You can attach a memo to any other record, including another 
memo. You can also add the date and time to a memo so you can keep an ongoing 
“log” of information, with the more recent items on top.

Click 
timestamp 
button...

...to place the 
current date 
and time on 
the first line of 
the memo
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Example
While telephoning a business contact, you type a memo detailing the important 
points of the call. Click the timestamp button, and the current date and time appear 
on the first line of your memo.

To Do List
The To Do List module keeps track of your tasks, or “to-do” items. You can give a 
To Do List item a title, a date of completion, and a priority, and set the item to 
repeat over any duration you wish. To Do List items appear in Date Book, and you 
can attach a To Do List item to any address card or memo.

Example
You need to gather materials for a report due the last Friday of each month. You’d 
also like a reminder the previous Monday that it’s time to start preparing the 
report. You can create a To Do List item for this, and set the item to repeat on the 
last Friday of each month. You can also set the reminder for five days before, on the 
previous Monday, to remind you that it’s time to start working on the report.

Opening and quitting Palm Desktop software
Palm Desktop software stores your information in one data file on your computer. 
You can close, print, and delete this file as you would any other. When you start 
Palm Desktop software, it automatically opens the last file that was opened. The 
name of the file appears in the title bar of each Palm Desktop window. 

To start Palm Desktop software, double-click the Palm Desktop icon in the Palm 
folder.

To quit Palm Desktop software:

■ Mac OS X: From the Palm Desktop menu, choose Quit.

■ Mac OS 9: From the File menu, choose Quit.
6
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Using Palm Desktop software with your handheld
Palm Desktop software shares information with four built-in applications on your 
handheld: Address Book, Date Book, Memo Pad, and To Do List. The information 
is exchanged when you perform a HotSync operation.

The modules in Palm Desktop software provide more features than the 
applications on your handheld. For information about how your information is 
transferred to your handheld during a HotSync operation, see the chapters in this 
guide that describe each module.

The first time you perform a HotSync operation with a new handheld or one that 
has been hard reset, the following occurs: 

■ A username in Palm Desktop software is added to your handheld.

■ A folder for the username is created in the Users folder inside the Palm folder. 
For example, if you entered Jane Garcia as your username, a folder called Jane 
Garcia is created in the Users folder. A file called User Data is created in the 
“Jane Garcia” folder. This is the data file that stores all your information.

NOTE Usernames appear in the User pop-up menu on the right side of the toolbar. 
You can change users by selecting a new name in the pop-up menu. 

Each subsequent time you perform a HotSync operation, HotSync Manager reads 
the username from the handheld and synchronizes the data in the folder of the 
same name.

NOTE Be sure you select the correct username from the User pop-up menu before 
entering data on Palm Desktop or performing a HotSync operation.

Creating and opening user data files
When you first install Palm Desktop software, it creates a new data file, called User 
Data, in the folder with the username you specified during the installation. Each 
time you perform a HotSync operation with your handheld, this same data file is 
used to synchronize data. 

We recommend that you use only this data file to synchronize with your handheld. 
Create other files only to back up data or to hold information for another user on 
the same computer.

Opening existing files
Palm Desktop software automatically opens the last data file that was opened. To 
open another file, click the User pop-up menu in the toolbar and select a new 
username.
7
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The name of the current data file appears in the title bar of each Palm Desktop 
window. 

Saving files
Your changes are saved as you work. You can also save a copy of a file to use as a 
backup. From the File menu, choose Save a Copy. In the Save a Copy dialog box, 
be sure to rename the file (or the original file will be overwritten), and then click 
Save.

If you are working with a new file, choose Save As from the File menu. Type a 
name for the file.

Closing windows and files
You can have one file open at a time. To close a file, choose Close File from the File 
menu. If you close a new file, you are prompted to save it first.

To close a Palm Desktop window, click the window’s close box or choose Close 
Window from the File menu. Closing a window does not close the file. Also, you 
can open multiple windows at the same time.

To exit Palm Desktop software, choose Quit from the File menu.

Changing your mind
If you make a mistake or change your mind while you are working, you can undo 
the latest change. To undo your most recent action, choose Undo from the Edit 
menu.

Using templates
If you have a number of similar events, addresses, memos, or To Do items to type, 
templates can help make your work easier.

A template resembles a new item, except it already contains some pretyped 
information. When you create a template, you choose what pretyped information, 
and how much, is in it.

The name of the current data file 
appears in the title bar of each window
8



Using templates
For example, if you have to add addresses for ten people and they all work in the 
same location, you can create a template that includes company name, address, 
and other information common to the new entries.

You can create a template either from an existing event, address, memo, or To Do 
List item—or from a new one. Once a template has been created, it appears in the 
Create menu, and you can use it to make new items. You then type only whatever 
remaining information the new item requires.

Creating templates from existing items
You can create templates from existing events, addresses, memos, or To Do List 
items. Select the item, then choose New Template from the Create menu. Give the 
template a name, and assign it a keyboard shortcut if you like. Then click OK. A 
keyboard shortcut is a sequence of keys that, when pressed together, are a faster 
way to execute a menu command than using the mouse.

The new template is available in the Create menu. Choose it, and a dialog box for 
a new item of its type appears with the template information filled in.

Creating templates from new items
You can create templates from new events, addresses, memos, or To Do List items. 
Choose Event, Address, Memo, or To Do from the Create menu. Type the 
information you want the template to have. Choose New Template from the Create 
menu. Give the template a name, and assign it a keyboard shortcut if you like. Then 
click OK.

The new template appears in the Create menu. You can continue to create other 
new items with the information contained in the new template.

Type a name for 
the template

Click the pop-up menu to assign the 
template a keyboard shortcut (optional)

The template appears 
in the Create menu
9
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Changing a template
If you need to correct the information in a template, create a new one, and then 
delete the old one.

Deleting templates
To delete a template, choose Delete Templates from the Create menu. Select the 
template you want to remove, then click Delete. Click Done when you’ve finished 
deleting templates.

Using the toolbar
You can click the buttons on the toolbar instead of choosing menu commands to 
execute common actions.

By default, the toolbar displays each button’s name. Move the pointer over the 
button to see an explanation of the button’s function. If you have a small monitor, 
you can collapse the toolbar, which hides button names. To do this, click the 
triangle at the left side of the toolbar.

To move the toolbar, hold the mouse down on the background of the toolbar and 
drag the toolbar to a new position. If you drag the toolbar near the menu bar, the 
toolbar automatically snaps back into the docked position.

To hide the toolbar, choose Preferences from the Palm Desktop menu in Mac OS X 
or from the Edit menu in Mac OS 9. Click the General button, and then choose 
None from the Toolbar pop-up menu.

Switching between users
The User pop-up menu is on the right side of the toolbar.

If you are the only person using Palm Desktop software on this computer, your 
name is the only name you see. 

Click to hide button names Select User

User pop-up menu
10



Marking records private
If others use the computer, the User pop-up menu shows the name of the person 
who most recently used it. 

NOTE Always check the pop-up menu to be sure you are using the correct data, 
especially before performing a HotSync operation. 

Click the User pop-up menu to do the following: 

■ Select from a list of available users and profiles

■ Create, delete, or modify users and profiles

Marking records private
You can mark any record private. Then, depending on whether you select to show 
or hide private records in Preferences, Palm Desktop software either displays or 
hides the records. To mark a record private, open the record, select Private, and 
click OK.

When you transfer a private record to your handheld during a HotSync operation, 
the record may become hidden or masked, depending on the options you select in 
your handheld’s Security application.

NOTE Masking of private records is available only on handhelds using Palm OS® 

software version 3.5 or later.

Hiding private records
You can hide all records that are marked private. Hidden records do not display in 
list views, Date Book views, menus, or Instant Palm Desktop application. They do 
not print and are not exported. The alarm for a hidden Date Book event does go 
off, but onscreen the alarm reminder says “Private Event” and does not display the 
actual event description. Hidden records are synchronized during HotSync 
operations.

To hide private records, choose Preferences from the Palm Desktop menu in Mac 
OS X or from the Edit menu in Mac OS 9. Click the General button, and select Hide.
11
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Setting preferences
To set preferences, choose Preferences from the Palm Desktop menu in Mac OS X 
or from the Edit menu in Mac OS 9.

Setting general preferences
Use the General preferences panel to specify settings for the Instant Palm Desktop 
menu, deletion warnings, color printing, sound effects volume, toolbar, date 
format, auto-attachments, new To Do List item priority, and private records. 

For information on setting auto-attachment preferences, see “Setting attachment 
preferences” in Chapter 9.

Choose default priority for new tasks

Choose long 
or short date 
displays

Choose whether 
the toolbar is 
docked, floating, 
or hidden

Choose a 
volume for 
sound effects

Select if you use a color printer

Select for 
warnings 
before items 
are deleted

Select to show the Instant Palm Desktop menu
Click 
General
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Setting alarm preferences
You can set the alarm preferences for your computer in Palm Desktop software. 
Choose Preferences from the Palm Desktop menu in Mac OS X or from the Edit 
menu in Mac OS 9, and then click the Alarms button.

The alarms for each appointment are set in the Event dialog box.

Setting font preferences
You can set different font types and font sizes for the list views in Address Book, 
To Do List, and Memo Pad. You can also select fonts and font sizes for memo text 
and the Date Book views. Choose Preferences from the Palm Desktop menu in Mac 
OS X or from the Edit menu in Mac OS 9, and then click the Fonts button.
.

Click 
Alarms

Select to 
display 
alarms on the 
desktop 
computer

Select to 
automatically 
add an alarm 
for new 
events you 
create

Click Fonts

Choose the 
font type 
and font 
size for 
items from 
the pop-up 
menus
13



Chapter 1 Introducing Palm™ Desktop Software
Setting decor preferences
A decor is a background that you can apply to the onscreen appearance of Date 
Book views and the list views in the other modules. To set a decor, choose 
Preferences from the Palm Desktop menu in Mac OS X or from the Edit menu in 
Mac OS 9, and then click the Decor button.

Select a decor from the list, and then click the Apply button to see how the decor 
looks with your file. Click OK to accept the decor or Cancel to reject it.

NOTE Decors appear onscreen only; they do not affect printing.

Click to see how your choice looks with the current file

Click Decor
Choose a decor from the list

Calendar with the Red Hot Chilies decor 
14
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Adjusting memory in Mac OS 9
In Mac OS 9, your computer sets aside a certain amount of memory for each 
application. You can change the amount of memory reserved.

You may want to increase the amount of memory set aside for the Palm Desktop 
software if you run out of memory while using the application, or if you have a 
very large data file. Increasing the preferred memory size to 5000K should 
eliminate any memory problems during these operations. If you use a Power Mac 
and have virtual memory off, Palm Desktop software requires more memory.

NOTE If you run out of memory while performing a HotSync operation, increase the 
allocation for the Conduit Manager application, not Palm Desktop software. The 
Conduit Manager is the application that manages HotSync operations. It is located in 
the Palm folder.

To change the memory allocation:

1. If Palm Desktop software is open, quit the application.

2. Open the Palm folder.

3. Click the application icon once.

To change the memory allocation for Palm Desktop software, click the Palm 
Desktop icon. To change the allocation for Conduit Manager, click the Conduit 
Manager icon.

NOTE If you click the application icon twice, you start the application. If that 
happens, choose Quit from the File menu and try again.

4. From the File menu, choose Get Info.

5. In the Get Info dialog box, choose Memory from the Show pop-up menu.

6. Double-click the Preferred Size box.

You see the size highlighted in the box.

7. Type a number, such as 5000, to change the memory size.

8. Close the Palm Desktop Info window.

The next time you start Palm Desktop software, the amount of memory you 
specified is available for the application.

For more information on managing memory, refer to the documentation that came 
with your computer.
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CHAPTER 2

Tutorial

With Palm™ Desktop software and your handheld, you can keep track of names, 
addresses, telephone numbers, e-mail addresses, events, memos, and to-do lists.

If you like to roll up your sleeves and learn by doing, this tutorial is for you. After 
you finish it, you will have a solid understanding of how Palm Desktop software 
works.

In this tutorial, you are the owner and manager of International Bakery, Ltd. You 
sell baked goods to delicatessens, cafés, and homes. Your business is growing 
nicely, and you need to keep track of information about your customers, suppliers, 
personal life, and family, so nothing gets overlooked. You carry your handheld on 
calls to customers and to suppliers.

After you have installed Palm Desktop software, you need to open the tutorial file.

1. Find the file called Bakery in the Tutorial folder, which is in the Palm folder.

2. Double-click the file’s icon .

The file opens.

Next, you need to go to the place in the file where the calendar information is.

1. Click the Go To button  on the toolbar, at the top of the screen.

2. Type 1/1/02 in the box.

3. Click OK.

Now, let’s put the software to work!

Creating an item in Address Book
The moment you finish installing the software the telephone rings, and it’s Susan 
Kenwood, a new customer. The first thing to do is create an address card for her.

1. Click the New Address button  on the toolbar.

A new address card appears where you can type the customer ’s information.

2. Notice the Name section of the card is expanded to make typing easier. Also, the 
First field is selected.

3. Type the first name: Susan.

4. Tab to the Last field, and type the last name: Kenwood.
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Tips:
■ You can move from field to field by pressing Tab (or press Shift-Tab to go 

backwards). 

■ Press Enter or Return repeatedly to open and close successive sections.

■ If you prefer, you can simply click the field you want to type in. The section 
expands and the field highlights, ready for you to type.

Finish typing the information so the address card looks like the one below. For 
telephone numbers, you need only type the digits—the parentheses and hyphens 
are added automatically. Press the Enter key when you’re through, but don’t close 
the address card yet — we’ll assign a category to it.

Assigning a category
After you’re done with the address card information, you’ll want to assign a 
category to this card. Categories are an easy way to group addresses, events, 
memos, and To Do List items. For example, you can assign the category “Office” to 
the addresses for your coworkers, as well as events, memos, and To Do List items 
relating to them.

You can assign up to two categories to each item: a primary category, and a 
secondary category. The primary category is the pop-up menu on the left; the 
secondary category is the one on the right. You can use primary and secondary 
categories however you choose.

NOTE Only the primary category for a record is transferred to your handheld when 
you perform a HotSync® operation.

Parentheses and hyphens 
are entered automatically
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Assigning a category
You can easily assign color-code information. For example, you can have items 
with the category “Office” appear in blue, and items with the category “Friends/
Family” appear in green. The color of an item is based on its primary category. If 
you have a color printer and have selected the correct print options, color-coded 
items will print in color, too.

Eight categories are already created, and you can add, remove, or change them at 
any time.

NOTE  The tutorial includes some additional categories.

1. Click the Other Information section of Susan Kenwood’s address card to 
expand it.

2. Choose Customers from the left, or primary, Categories pop-up menu.

Primary category Secondary category
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3. You can choose another category from the right, or secondary, Categories pop-
up menu. Otherwise, leave it blank.

4. If you like, fill in some of the other fields on Susan’s address card.

5. When you’re done, press Enter to collapse the open section. 

6. Click the card’s close button  in the upper-left corner to put it away.

Displaying list views
The address card is a good way to view and change one person’s information. But 
you’ve got a lot of people in your Bakery file. To scan them, or jump quickly to 
another person’s card, view your addresses as a list.

1. Click the Addresses button  on the toolbar.

You see the addresses listed in rows and columns.

2. Choose an item in the list, and double-click it to open the address card.

3. Click the address card’s close button in the upper-left corner to put it away.

4. Click several items in the list as you hold down the a key.
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Sorting items in Address Book
5. Click an item toward the top of the screen. All the previously selected items are 
now unselected. Press and hold the Shift key. Now click an item five or six lines 
below the first one you clicked. The two items you clicked, plus all items in 
between, become selected.

6. To deselect all addresses, scroll down to the bottom of the list, where there are 
no items. Click there. All items are deselected.

There are three separate list view windows: one for addresses, one for memos, and 
one for To Do List items. All three work the same way. You can enlarge any list 
view window—or scroll up, down, left, or right—to see all of your data.

You can attach, delete, and duplicate multiple items quickly in a list view by 
selecting more than one item at a time.

Leave the address list open—we’ll use it in the next section.

Sorting items in Address Book
Right now, your address list is sorted by name. Some operations may be easier if it 
were sorted by company.

1. Find the Company column in the address list. Scroll left or right if you need to.

2. Click the word Company at the top of the column. (Don’t click the  button 
next to it.)

This re-sorts the list so all items are now sorted by company. Notice that the word 
Company is highlighted. Highlighting indicates which field was used to sort the 
information.

You decide it would be more convenient if the information were sorted by 
company, and then by name within each company.

1. Choose Sort from the View menu.

In the Sort dialog box, Company appears in the Primary pop-up menu.

2. Choose Full Name from the Secondary pop-up menu.

3. Click OK.
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In the address list, notice the dotted underline beneath the Full Name, indicating 
that it is the secondary sort column.

We’ll continue using the address list in the next section, so leave it open.

Viewing selected items in Address Book
You want to take a quick look at your customers’ address cards. But there are many 
more records in your file than just those for your customers. You want to show the 
listings for only your customers—while hiding the others.

You can set the Categories field so you see only customers. This setting is called a 
filter.

1. If the address list is not already open, click the Addresses button  on the 
toolbar.

2. Click the  button next to the word Categories at the top of the categories 
column.

3. Choose Customers from the pop-up menu.

The list now shows only your customers.

Let’s show the rest of the Address Book records again.

1. Click the  button next to the word Categories at the top of the categories 
column.

2. Choose No Filter from the pop-up menu.

The entire set of Address Book items is visible again. If you prefer, you can also 
show the hidden items by clicking the Show All button in the upper-right corner 
of the list window. (If you’re already viewing all the items this button is not 
available.)

You can close any open windows by clicking each window’s close button in the 
upper-left corner.
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Finding an Address Book item
Finding an Address Book item
Later in the day, you want to call Susan Kenwood, and you need her telephone 
number.

1. Click the Find button  on the toolbar.

2. Click the Addresses button  inside the Find dialog box. Make sure Display 
Results in List Window is deselected.

3. Type Kenwood in the text box.

Her address appears in the dialog box—probably before you even finished 
typing her last name.

4. Double-click Susan Kenwood’s name in the Find dialog box, and you see her 
address card.

After you’ve found Susan Kenwood’s address card, you can click the telephone 
icon  next to her telephone number to dial her phone number automatically, if 
you have the correct modem and telephone connections.

5. Close the address card.

You can also find other information in a similar way, whether it’s a To Do List item, 
memo, or an event. If you don’t know where to look for the information, click 
Entire File to list every place the information appears.
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Synchronizing addresses with Address Book on your handheld
After you add or change addresses, you can make sure your handheld has the 
same information by performing a HotSync operation. The HotSync operation 
exchanges new material between Palm Desktop software and your handheld and 
updates all changes made in either location. For example, the address you created 
for Susan Kenwood would appear on your handheld in the Address Book 
application after a HotSync operation.

This tutorial doesn’t step through a HotSync operation. Instead, you can learn 
about HotSync operations using your own data by reading “About HotSync 
operations” in Chapter 12.

Creating an event in Date Book
Next, you need to schedule an appointment you’ve made with the representative 
from your bakery supplies wholesaler. You’re going to discuss new spices for your 
international line of breads. The appointment is tomorrow, from 9 AM to 10 AM.

1. Click the Date Book button  on the toolbar.

If you don’t see the Day view, click the Day tab on the right side of the window.

2. Click the Go To button  on the toolbar.

3. In the Go To dialog box, click the arrows  either backward or forward until 
you see January 2002.

4. In the Go To dialog box, choose any day in January 2002 for the appointment, 
click it, then click OK.

You’ll see that date in the Day view.

5. Scroll up or down until you see 9 AM in the events window, on the left side of 
the Day view.

6. Move the pointer to the events window. The pointer becomes a crosshair.

7. Place the crosshair on the line representing 9 AM, then click and drag down 
until the box reaches 10.

A one-hour event is created, from 9 AM until 10 AM.
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Creating an event in Date Book
8. Type Meeting with Denise Garcia inside the new event box.

9. Click outside of the event box to deselect it.

The Auto-Attachments dialog box appears. There is an address card for Denise 
Garcia, and you can attach it to this event.

10. Click Attach.

We’ll discuss attachments in more detail later, in the “About attachments” 
section.

To change the start or end time of an event, click the event to select it. Drag the 
upper arrow up or down to change the event’s start time. Drag the lower arrow up 
or down to change the event’s ending time. 

If you prefer, you can also change the event start or end time by double-clicking the 
event, then changing the time in the Event dialog box.

Click outside of the event to deselect it.

Leave the Day view open for the next section.

Drag up or down

The paper clip pop-up menu 
shows that this event has an 
attachment.
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Moving an event
Unfortunately, Denise Garcia just called you to say she has an appointment 
conflict. She asks that the meeting you’ve scheduled be changed to 10 AM. You 
need to move the event in Date Book.

1. Move the pointer over the event.

2. Drag the event downward so the top of the event lines up with 10 AM.

The event now starts at 10 AM and ends at 11 AM.

You can also change the time in the Event dialog box, if you prefer. Drag the event 
back up to where it was, so that it starts at 9 AM and ends at 10 AM. Now practice 
moving the event using the Event dialog box.

1. Click the event once, so it becomes selected.

2. Double-click the event box anywhere except directly over the event text.

3. When the Event dialog box opens, change the beginning time from 9 AM to 10 
AM. You can type 10.

4. Click the box for the ending time. It automatically changes to 11 AM.

5. Click OK to close the dialog box.
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Setting alarms
The next thing we’re going to do is confirm that we have set a reminder, or alarm, 
for this event.

Setting alarms
You’re not sure you’ll remember that the appointment with Denise Garcia has been 
changed, so you want a reminder shortly before it is to occur. You can set an alarm 
for this event. An alarm is a dialog box that appears on your computer screen to 
remind you of an event. When you synchronize data with your handheld, the 
alarm is also set to go off on your handheld.

The default setting for alarms on Palm Desktop software is off. If you wish to be 
reminded by these onscreen alarms, you must turn on the alarm setting.

NOTE This setting affects all users on Palm Desktop software. 

1. Choose Preferences from the Palm Desktop menu on Mac OS X or from the Edit 
menu on Mac OS 9.

2. Click the Alarms button in the Preferences dialog box.

3. Select the check box for Show alarm dialogs. 

NOTE You can change the alarm settings for an individual event in the Event 
dialog box.

4. Click OK.

You want to set this alarm to go off at the original time of the event (9 AM) to 
remind you that the event changed.

Click Alarms
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1. Double-click the Denise Garcia event box anywhere except directly over the 
event text.

2. In the Event dialog box, make sure the Set Alarm check box is selected.
.

3. Type 60 over the existing number in the box.

4. Leave Minutes Prior selected in the pop-up menu.

5. Click OK.

At 9 AM the following dialog box appears.

If you want another reminder later, type when you want that reminder to appear, 
then click Snooze. 

Try setting up your own reminder:

1. Check your computer’s current date and time settings. (If you’re not sure how 
to do this, or you need to correct them, consult your computer operating 
system’s user guide.)

2. Click the New Event button  on the toolbar to create a new event.

3. Make the event for today’s date.

4. Check the current time, then set the start time of the event for fifteen minutes 
from now. (The end time can be whatever you like.)

5. Set an alarm to warn you ten minutes in advance.

6. Click OK.

Within five minutes you should see a reminder on your screen.

When you’re through experimenting with reminders, you can close any open 
windows if you like.
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Showing the three Date Book views
Showing the three Date Book views
The Date Book has three views: Day, Week, and Month. First, let’s try the three 
ways to choose one of these views. Then we’ll examine the differences among the 
views.

To switch among the three Date Book views:

1. Click the Date Book button  on the toolbar repeatedly, until you have seen 
each view.

2. Click the tabs on the right side of the Date Book until you have seen each view.

3. Choose Date Book from the View menu, and then choose one of the three views 
from the submenu. (You can also use the keyboard shortcuts that are listed in 
the menu.)

The three Date Book views offer you different ways of looking at your schedule.

■ The Day view shows one day’s event and To Do List items. On the left, you see 
events. The window scrolls to reflect the time of day. On the right, you see the 
day’s To Do List.

Keyboard 
shortcuts

Day view
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■ The Week view shows events and To Do List items for a number of days you 
choose, from one to seven. Events are listed on top, while To Do List items are 
listed beneath each day. You can click the + and - buttons to change the number 
of days displayed—from one day to as many as seven.

■ The Month view shows the current month’s events and To Do List items.

Leave one of the Date Book views onscreen for the next section.

Week view

Month view
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Creating an untimed event
Creating an untimed event
National Bread Week is coming up! You must note this event on your Date Book as 
an untimed event. 

1. Go to the Month view for January 2002.

2. Click the New Event button  on the toolbar.

3. For the event’s name, type National Bread Week.

4. Type 1/20/02 in the Date box. (This is the event’s start date.)

5. Click No Time.

6. Click the Repeat Event check box to select it.

7. Type 1/26/02 in the Until box so the event spans an entire week.

8. Choose Business from the primary Categories pop-up menu on the left.

9. Click OK.

An untimed repeating event appears on the Date Book.

Notice that the event can stretch over more than one day. (You can also have an 
event that only stretches across one day.) You can reposition the event or change 
its duration.

10. Double-click the event. 

11. In the Change Repeating Item dialog box, make sure that All Events is selected 
and then click OK.

12. When the Event dialog box opens, change the date in the Until box to 1/23/02. 
Click OK. Notice that the event has been shortened by two days.

13. Double-click the event again, and change the date in the Until box back to 
1/26/02. Click OK. The event once again spans the entire week.
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14. Click the event and drag it to another week.

The untimed repeating event now spans that week.

Close Date Book if you like.

Synchronizing events with the Date Book on your handheld
A HotSync operation exchanges new events between Palm Desktop software and 
your handheld and updates all changes to events made in either location. For 
example, the event you made for 10 AM with Denise Garcia would appear on your 
handheld in the Date Book application after a HotSync operation.

This tutorial doesn’t step through a HotSync operation. Instead, you can learn 
about HotSync operations using your own data by reading “About HotSync 
operations” in Chapter 12.

Creating a To Do List item
Your appointment with your bakery wholesaler is the day after tomorrow. Before 
the appointment, you need to make a list of the spices and bakery supplies that you 
need. You want to remind yourself to complete this task before the appointment.

1. Click the New To Do button  on the toolbar.

2. In the Title text box, type Make a list of supplies.

3. Leave the Priority at Medium.

4. Make sure the Schedule To Do check box is selected.

5. Type 1/15/02 in the Date field.
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Creating a memo
6. Leave Carry Over After Due selected.

7. Select the Remind check box and type 1 in the days before box that appears.

This reminder occurs only on Palm Desktop software; the handheld doesn’t 
support reminders on To Do List items.

8. Choose Business from the primary (left) Categories pop-up menu.

9. Click OK.

You now have a To Do List item, with a reminder that appears in Date Book the day 
before the item is due. After you click OK, the item list appears so you can see your 
other items, as well.

A HotSync operation also exchanges new To Do List items between Palm Desktop 
software and your handheld and updates any changes to items made in either 
location.

Close the To Do List application by clicking the close button in the upper-left 
corner of the window.

Creating a memo
Now it’s time to make the list of supplies needed.

1. Click the New Memo button  on the toolbar.

2. Type a title for the memo: Supplies needed.

3. Type 1/15/02 for the date. You can leave the time as is.

4. Choose Business from the primary (left) Categories pop-up menu.

5. Press Return and type the supplies you need:

20 sacks of flour
5 containers of salt
10 packages of yeast
5 containers of sugar
2 containers of cinnamon
1 container of poppy seeds
1 container of caraway seeds
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1 container of anise seeds
1 container of dried rosemary

6. Close the Memo window. This saves the memo and puts it away.
If you want to refer to this memo or change it, click the Memos button  on 
the toolbar and double-click the memo from the list.

A HotSync operation also exchanges new memos between Palm Desktop software 
and your handheld and updates any changes to memos made in either location.

After you’re through, close the memo list. If the To Do List is open, close it as well.

About attachments
With attachments, you can connect any event, address, memo, or To do List item to 
another, so related information is always available. You can attach an existing 
record to another by dragging the record onto the record you want to attach it to. 
If you are attaching an Address Book card or memo, you can create an attachment 
by selecting the icon in the title bar of the address card or memo card (wait until 
the icon darkens) and dragging it to the record you want to attach it to.

For example, if you have created an event—and you also have an address for the 
person you have the appointment with—you can attach the event to the address 
by dragging the event to the address card. You could also do the reverse: drag the 
address card (by the icon in the title bar) to the event. Once you do that, the items 
are attached, and you can quickly jump from one to the other to gather related or 
background information.

NOTE Attachments do not transfer to your handheld. When you perform a HotSync 
operation with records that contain attachments, each record is transferred to the 
handheld, but the relationship between the records is not transferred.

Creating attachments
Let’s create an attachment so you can see how they work.

You have an appointment with Denise Garcia, the representative from your bakery 
supplies wholesaler. You have already created this event in Date Book. When you 
did that, you were prompted to attach Denise Garcia’s address card and the new 
event.

Now let’s attach the memo you just created—the one listing the supplies you 
need—with the Denise Garcia event.
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Creating attachments
1. Click the Date Book button  on the toolbar until you see the Week view.

2. Find the event that says Meeting with Denise Garcia. It’s in January 2002, in the 
morning. (The day it appears in your Date Book can vary.)

3. Click the Memos button  on the toolbar.

4. Shrink the size of the Memo List window and the Week view window so you 
can see the memo list and the event at the same time.

5. Scroll through the memo list until you see Supplies needed. Click this line once 
so it is selected.

6. Move the pointer over the gripper icon .
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7. Drag the Supplies needed memo to the event that says Meeting with Denise 
Garcia. As you drag, you’ll see a pointer, and a box appear around the event.

8. A paper clip appears once Denise Garcia’s event is selected. Release the mouse 
button.

The memo is now attached to the event.

9. Look at the memo in the memo list, and notice it has a paper clip pop-up menu 
next to it. This shows the memo has an attachment.

10. Click and hold the paper clip pop-up menu to reveal the attachments menu. 
Choose the event title.

The Date Book appears, showing you the event.

Paper clip 
pop-up 
menu
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Printing labels
11. Click the paper clip pop-up menu in the event.

Notice the event now has two attachments: the memo you just attached (under 
Memos), and Denise Garcia’s address (under Addresses), which was automatically 
attached when you created the event. You can jump to either the memo or address 
if you like.

You can create as many different attachments as you like to cross-reference 
whatever events, addresses, memos, or To Do List items you choose.

There are special sound effects for attaching one type of item to another. You can 
adjust the volume of these sound effects in the General area of the Preferences 
dialog box. (Choose Preferences from the Palm Desktop menu in Mac OS X or from 
the Edit menu in Mac OS 9 to open the dialog box, and then click General.)

After you’re through, close each window by clicking the close button in the upper-
left corner.

Using the Attach Existing Item feature
If you prefer, you can use another method to create attachments.

1. Click to select any event—or click any address, memo, or To Do List item from 
the list view.

2. Choose Attach To from the Create menu, and then choose Existing Item.

3. Follow the instructions in the Attach Existing Item dialog box. Click the gripper 
in the dialog box and drag the selected item to another item.

Printing labels
It’s time to do some advertising. You want to send flyers to a list of customers 
already in your Bakery file, and you need to create mailing labels for them. For this 
tutorial, we’ll print a test run on regular paper, rather than actual labels.

1. Click the Addresses button  on the toolbar.

2. With the list showing, click the Print button  on the toolbar.

3. The first time you print, you see a box asking if you use a day planner. To set up 
your day planner, choose your brand of day planner in the upper pop-up menu. 
In the lower pop-up menu choose the day planner binder size you use.
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If you do not use a day planner, leave the upper pop-up menu showing None. 
(You can always change these settings later.)

4. Click OK.

5. When the Print dialog box opens, make sure the Addresses button is selected.

6. Choose Mailing Labels from the Print As pop-up menu.

The other pop-up menus contain settings for mailing labels. For this exercise, 
leave these settings as they are. The Preview area shows you a sample of what 
your label page will look like.

7. Click Print.

8. When the Print dialog box appears, type 1 in the From and To boxes to print only 
the first page of labels.

9. Make sure your printer is connected and switched on, and then click Print.

One page of “labels” prints on your printer ’s regular paper. If you like, print 
another page with different options to see what you get.
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Using Instant Palm™ Desktop application
Using Instant Palm™ Desktop application
The Instant Palm™ Desktop application provides you with quick access to many 
of the most frequently used features of Palm Desktop software and HotSync 
Manager.

In Mac OS X, the Instant Palm Desktop menu appears when you click and hold the 
Palm Desktop icon in the dock if Palm Desktop is running. In Mac OS 9, the Instant 
Palm Desktop menu appears near the upper-right corner of the screen. It is always 
available unless you set your Instant Palm Desktop menu preference to off. 

In Mac OS 9, you see the Instant Palm Desktop icon in the upper-right corner of the 
screen. 

In Mac OS X, the Instant Palm Desktop menu appears when you click and hold the 
Palm Desktop icon in the dock (Palm Desktop must be running for the menu to 
appear).

Instant Palm Desktop menu icon in Mac OS 9

Click and hold the Palm Desktop icon in the dock
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Displaying frequently used phone numbers
For quick access, you can display the names and telephone numbers of people you 
call frequently in the Instant Palm Desktop menu.

1. Choose Find Address from the Instant Palm Desktop menu.

2. When the Find dialog box appears, type denise garcia. (Case doesn’t matter.)

3. When her name appears in the list, click it once to select it.

4. Click Add to Menu.

5. Select a check box for each telephone number you want included in the Instant 
Palm Desktop menu. (To remove telephone numbers from the Instant Palm 
Desktop menu, you deselect these check boxes.)

6. Click OK.

Select to add to 
Instant Palm Desktop 
menu
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Backing up your data
You’ll now see Denise Garcia in the Instant Palm Desktop menu under Addresses.

You can also add or remove telephone numbers to the Instant Palm Desktop menu 
by viewing the address card in Palm Desktop software, then clicking the Phones 
section. Select the telephone numbers you want displayed in the Instant Palm 
Desktop menu. Deselect the telephone numbers to remove them from the Instant 
Palm Desktop menu.

Backing up your data
Your data is valuable. Always back it up regularly so you’ll be protected in the 
event of equipment failure, inadvertent file deletion, or other mishap.

To back up your Palm Desktop user data file, make a copy of your data file. Choose 
Save as Copy from the File menu, then type a new name such as “Copy of Arthur 
Kong3 Jan” in the Save as Copy dialog box.

Applying Decors
Decors are a fun way to personalize your Palm Desktop software appearance with 
colors and textures.

1. Open your Palm Desktop file by double-clicking its icon. You can also choose 
Open Palm Desktop from the Instant Palm Desktop menu.

2. Choose Preferences from the Palm Desktop menu in Mac OS X or from the Edit 
menu in Mac OS 9.

Select to add to 
Instant Palm Desktop 
menu
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3. Click the Decor button.

4. Choose any of the decors from the scrolling list.

5. Click Apply to see your file redecorated with that decor.

You can change the decor at any time. Decors change onscreen appearance only. 
They do not change the way your information looks when it prints.

Where to go from here?
Congratulations! You’ve finished the tutorial. You’ve seen just some ways Palm 
Desktop software can make your life a little bit easier.

■ If you’re ready to synchronize the information in Palm Desktop software and 
your handheld, see “About HotSync operations” in Chapter 12.

■ If you have any questions the tutorial didn’t answer, scan the Contents of this 
guide. It’s a quick way to find the information you need. Or check the Index if 
you know exactly what you’re looking for.

Palm Desktop software also features an extensive onscreen Help system. It’s 
available onscreen whenever you need it—just choose Palm Desktop Help from 
the Help menu. You can also access help by clicking the question mark in a dialog 
box to go directly to a relevant Help topic.
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CHAPTER 3

Working with Address Book

This chapter explains the basics of working with contact information and address 
lists.

About Address Book
The Address Book application in Palm™ Desktop software helps you manage 
information about your business associates, friends, family, and other people you 
contact. You can enter names, addresses, telephone numbers, e-mail addresses, 
birthdays, web sites, comments, and more. Addresses can be organized by 
category, sorted, printed, and searched by any criteria. You can also dial the 
telephone and automatically copy address information into letters. 

Addresses can be exported as a vCard file and imported to another person’s Palm 
Desktop Address Book or any personal information manager that supports the 
vCard standard. This feature makes it easy for you to share addresses between 
your Mac computer and a Windows computer.

Addresses you enter in Palm Desktop software appear in the Address Book 
application on your handheld after a HotSync® operation.

Viewing addresses
You can view your addresses by:

■ Address card, for viewing one address at a time. You can also change existing 
address information when viewing the address card.

■ Address list, for viewing contact information many records at a time.

To see a list of your addresses, choose Address List from the View menu, or click 
the Addresses button on the toolbar.

For more information on list views, see Chapter 7.
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Creating and changing addresses
To create an address, choose Address from the Create menu, or click the New 
Address button on the toolbar. You see a new address card with the Name section 
expanded and the first name field highlighted. As you type information, press Tab 
to move from field to field (or Shift-Tab to move backwards). Press Enter or Return 
to move from section to section.

Changing information
You can change information in an existing Address Book item by locating the item 
in the list and double-clicking it.
.

You can also use the Find feature to locate the item you want. For more 
information, see Chapter 8.

The address card is divided into sections for easy viewing and editing. Click a 
section to expand it so you can work more easily. If you click a specific field, that 
field is highlighted when the section expands. When you click outside of the 
expanded portion of the section, it collapses.

Enter information in 
an address card

Double-click an item in the 
list to edit it
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Creating and changing addresses
If you include a country in a person’s address, the completed address card, and any 
printouts, are automatically formatted for that country’s address style. You can 
edit these international address styles in Address Book preferences.

The Other Information section includes fields for Comments, Email, Web Site, 
Birthday, Age, and Categories, and a number of custom fields (you set the number 
of custom fields in the Address preferences dialog box). See “Transferring 
addresses to your handheld” later in this chapter for information about how the 
fields in the Other Information section transfer to your handheld.

The Comments field is an excellent place to note brief information that is unique to 
a particular person. If you have information that is likely to apply to many of your 
contacts—for example, a spouse or partner, children, favorite colors—consider 
creating a custom field for that information. You can store more extensive 
information in a memo that is attached to the Address Book item. For more 
information, see Chapter 5 and Chapter 9.

When you add or change information, the modification date is displayed in the 
lower-right corner of the address card. Changes you make to items in the address 
list are updated on your handheld after a HotSync operation.

Click to 
expand and 
edit 
information
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Chapter 3 Working with Address Book
When you expand the Phones section, you’ll see check boxes to the right of each 
telephone number. Select one of these check boxes, and that telephone number 
appears in the Instant Palm™ Desktop menu. Deselect the check box to remove the 
telephone number from that menu. For more information, see “Working with 
addresses” in Chapter 13.

Using and changing selection lists
Some fields in the address card provide a pop-up menu from which you can choose 
an entry instead of having to type one. Those fields have a triangle  next to them. 
Click the triangle and choose one of the entries from the pop-up menu. 

When you type in a field that has a selection list, whatever you type is added to the 
pop-up menu. (You can turn this feature off. See “Setting Address Book 
preferences” in this chapter.)

To automatically add newly entered items to the Email, Web Site, and Custom 
fields selection lists, choose Address from the Create menu. In the Other 

Name section: for 
name, title, and 
company 
information

Address section: 
for address 
information

Other Information 
section: for 
comments, e-mail, 
web site, birthday, 
category, and 
information you 
choose

Address section: 
for address 
information

Phones section: for 
telephone and fax 
numbers. Click box 
to show number in 
Instant Palm 
Desktop menu

Choose an entry 
from the pop-up 
menu
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Creating and changing addresses
Information section, click the triangle next to the field and choose Field Options 
from the pop-up menu. Select the Automatically check box.

NOTE Only newly entered items are added to selection lists. Items from data that has 
been imported are not added. If you want to add imported items to a selection list, 
click the pop-up menu for that field and choose Add to Menu.

Using auto-completion
If you’re typing in a field with an entry list, matching entries are displayed as you 
type. You then either press Tab or click outside of the field to accept the auto-
completed entry, or keep typing if the entry is not what you want. You can turn the 
auto-completion feature on or off in Preferences.

Using auto-capitalization
You can have any word you type automatically capitalized. If this preference 
setting is on, the first letter of each word you type is automatically capitalized after 
you press Tab or click out of that field. For the Name field and both Address fields, 
you can set this option in the Address preferences dialog box. For the Email and 
Custom fields, set this option by clicking the triangle  next to the field in the 
Other Information section and choosing Field Options.

Formatting telephone numbers
Telephone numbers are automatically formatted. After you type the numbers and 
press Tab or click outside the field, the numbers are formatted with the telephone 
number format you have specified in the Address preferences dialog box.

You can specify the default area code in the Address preferences dialog box. When 
you do that, the area code is inserted when you type a telephone number without 
one. Type the seven-digit telephone number, then press Tab or click out of the field. 
The local area code appears and the telephone number is formatted.

NOTE Telephone numbers do not format automatically unless you specify a default 
area code in Address preferences.

Setting custom field options
In the Other Information section at the bottom of the address card, you can 
customize the Birthday, Email, Web Site, and Custom fields. To make it easier to use 
these fields, you can change their names by clicking the  button and choosing 
Field Options from the pop-up menu.
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Chapter 3 Working with Address Book
If you are an AppleScript developer, you can create an AppleScript file and attach 
it to a custom field; then activate that script with a button. First create the 
AppleScript file. Next, place the completed AppleScript file in a folder named Field 
Options Scripts, which you create within the Palm Desktop folder in the following 
location:

■ Mac OS X: To make the AppleScript available to a single user, create the folder 
in <Hard Disk>/Users/[Mac username]/Library/Application Support/Palm 
Desktop/. To make the AppleScript available to all Palm Desktop users, create 
the folder in <Hard Disk>/Library/Application Support/Palm Desktop/.

■ Mac OS 9: Create the folder in <Hard Disk>/System/Application Support/
Palm Desktop/.

In the address card, click the Other Information section, and then double-click the 
custom field name. After that’s done, select the AppleScript Button check box in 
the Custom Field Options dialog box, choose the AppleScript file from the Script 
File pop-up menu, then choose a button from the Button Icon pop-up menu. The 
button appears next to the custom field. Click it, and the AppleScript activates.

NOTE For AppleScripts to run, you must have the proper AppleScript system 
extensions installed on your computer. For more information, see the documentation 
that came with your computer's operating system software. For information on 
creating AppleScripts, see the documentation that came with your AppleScript 
developer tools.

Choose Field 
Options to change 
the field name

Type the new field name here

Choose how you want entries capitalized

Select to automatically add entries you 
type to the pop-up menu

Select to display a button for access to 
attached documents, e-mail, or the web
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Creating and changing addresses
You can change the items that appear in a custom field pop-up menu by choosing 
Edit Menu. Use it to add, change, or remove menu items from the pop-up menu. 
The Edit Menu dialog box appears.

Using the Email and Web Site fields
You can send electronic mail and browse web pages automatically by using the 
Email and Web Site fields together with an e-mail application and a web browser.

NOTE You must have an e-mail application set up on your computer to use the Email 
button. You must have Netscape Navigator, Microsoft Internet Explorer, or other 
browser set up to use the Web Site button.

In the address card, click the Other Information section. Type a person’s e-mail and 
web site information in the Email and Web Site fields. Then click the button to the 
left of either field.

■ The Email button launches your e-mail application, creates a new e-mail 
message, and inserts the person’s e-mail address in the To field for you. Your 
e-mail address appears in the From field.

■ The Web Site button launches your Internet browser, inserts the person’s web 
site address, and takes you to the person’s web site.

Using Birthday Minder
You can keep track of birthdays using Address Book. In the Other Information 
section of the address card, type the person’s birthday in the Birthday field. When 
you press Tab or click out of the field, an untimed event is created for that person 
on his or her birthday. A To Do List item is scheduled for the birthdate, and a 
reminder is added to the day five days before the birthday.

Click to delete a selected item from 
the pop-up menu
Click to edit a selected menu item
Click to add a new menu item to the 
pop-up menu

Click to send an
e-mail message

Click to see the 
person’s web site
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Chapter 3 Working with Address Book
You can type just the birth month and day if you prefer. If you type the birth year 
as well, the person’s age displays in the card. You can also type the birthday month 
and day, then enter the age in the Age field—the birth year is inserted in the 
Birthday field. You may use any of these formats to enter a birthday:

The Birthday and Age fields transfer to the Note field for the corresponding 
Address Book item on your handheld.

Copying Address Book information
You can copy information from an address card and paste it into a memo, another 
address card, or another application. Choose Copy Special from the Edit menu to 
copy the person’s full name, address, company—or a combination of these. You 
can choose between copying the primary address, stored in the address section on 
the left side of the address card, or the secondary address, stored in the address 
section on the right side of the card.

If you want to copy the information in one field only, click that field to select it, 
make sure the text in the field is highlighted, then choose Copy from the Edit 
menu.

5/26/1960 5.26.1960

5.26.60 May 26, 1960

5/26 May 26, 1960

5.26 May 26
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Transferring addresses to your handheld
Transferring addresses to your handheld
New Address Book items and changes to existing items are transferred to the 
Address Book application on your handheld when you perform a HotSync 
operation. This operation also moves new items from the Address Book into the 
Palm Desktop software address list, and synchronizes all changes made on either 
the handheld or the computer.

The following list shows the details of the data transfer for addresses between your 
computer and your handheld:

Palm Desktop software 
items Transfer to Address Book on handheld as

Last name Last name

First name First name

Prefix, Suffix, 
Nickname

Do not transfer to the handheld

Title Title

Company Company

Division Does not transfer to the handheld

Phone 1 and 
extension

Work phone with extension in the same field (first phone 
field)

The default label of the first phone field is “Work.” If you 
change the label of the field, Phone 1 will continue to be 
transferred to the first phone field in the handheld.

Phone 2 and 
extension

Home phone with extension in the same field (second phone 
field)

Phone 3 and 
extension

Fax phone with extension in the same field (third phone 
field)

Phone 4 and 
extension

Mobile phone with extension in the same field (fourth phone 
field)

Email E-mail (fifth phone field)

Phone number 
formats

As entered

Comments Address note, comment section

Street, City, State, 
Zip, Country

Address, City, State, Zip, Country

Secondary address Address Book note, secondary address section
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Chapter 3 Working with Address Book
Marking addresses for printing
In some cases you may want to print only some of the addresses in your list. For 
example, you might want to address envelopes only to your coworkers, or print 
labels only for your friends and family.

You can mark items in the address list. Choose Address List from the View menu, 
or click the Addresses button on the toolbar. Within the address list, select the box 
to the left of each item you want to mark.

If you want to quickly mark or unmark all of your addresses, choose Mark All or 
Unmark All from the Edit menu.

Categories The first category you assign to an entry is transferred to the 
handheld. The second category does not transfer. See 
“Transferring categories to your handheld” in Chapter 8.

Birthday Address Book note

Age Address Book note

Web Site Address Book note

Custom fields 1 to 4 Custom 1 to Custom 4

Custom fields 5 to 9 Do not transfer to the handheld

Private Private

Attachments to 
entries, such as 
memos, Date Book 
events, or To Do List 
items

Relationships do not transfer to the handheld.

The Address Book item and each attached item transfer to 
their corresponding applications on the handheld. The 
relationship between the items, however, does not transfer.

File attachments, 
such as letters

Do not transfer to the handheld

Palm Desktop software 
items Transfer to Address Book on handheld as

Select the 
box next to 
an item to 
mark it
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Attaching a letter to an Address Book entry
You can also mark items individually by clicking the box in the corner of the 
address card.

To print the marked items, choose Print from the File menu and then click 
Addresses. From the “Which Addresses” pop-up menu in the Print dialog box, 
choose “Marked addresses.” For more information on printing Address Book 
entries, see Chapter 11.

You can also mark items for sorting and filtering the address list. For more 
information, see Chapter 7.

Attaching a letter to an Address Book entry
You can copy the name and address from an Address Book entry into a 
ClarisWorks, AppleWorks, or MacWrite Pro template letter and then attach a copy 
of the completed, addressed letter to the address card. You must have ClarisWorks 
4.0 or higher, AppleWorks, or MacWrite Pro 1.5v3 installed on your system. The 
personalized letter template is stored in the Letter Templates folder within 
Application Support/Palm Desktop/.

NOTE The letter you create using this process is not transferred to your handheld in 
a HotSync operation.

Adding an address to a letter template
Open an address card, click the address you want to use for your letter; then click 
the Attach Letter button directly above the address.

Click the box to 
mark this item

Click the button 
above the address 
you want to use
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Chapter 3 Working with Address Book
The first time you use this feature, a message appears suggesting you personalize 
the letter template. Click OK, then click Personalize in the Attach Letter dialog box.

The letter template opens in your word processor. It contains instructions for 
personalizing it.

When you have finished personalizing the letter template, return to the Attach 
Letter dialog box. Choose your word processor from the Word Processor pop-up 
menu, then select a template. Click Attach. The word processor opens the letter 
template, the person’s name and address are inserted, and the word processor’s 
Save As dialog box opens. Choose a name for the letter and click OK to save it.

An attachment from the letter to the person is created. Click the person’s name 
from the paper clip pop-up menu  and select the letter to open it in your word 
processor, edit the address as necessary, and print it.

See online help for additional information about working with letter templates.

Deleting addresses
You can delete an Address Book item at any time. To delete an item, open the 
address card you want to delete, or select it from the address list. Then choose 
Delete Address from the Edit menu, or click the Delete button on the toolbar.

The next time you perform a HotSync operation, items you deleted from Palm 
Desktop software are also deleted from your handheld.

For more information about archiving items you delete from your handheld, see 
“Archiving data you delete from your handheld” in Chapter 12.

Dialing telephone numbers
You can dial the telephone automatically if there is a modem connected to your 
computer. You can also dial a telephone number by playing the dialing tones 
through your computer’s speaker.

Choose the template you want 
to use

Click to put your 
address in the letter

Choose the word processor 
(choose ClarisWorks for 
AppleWorks)
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Dialing telephone numbers
NOTE When you open Palm Desktop software, it determines the methods that are 
currently available for dialing a telephone and displays them in Dialing preferences. 
If your computer uses a version of Mac OS X and it also has a modem, but Modem 
is not listed in the Dial through pop-up menu, that is because the particular 
combination of operating system and Palm Desktop software on your computer does 
not enable use of a modem.

To dial a telephone number using a modem, make sure your modem is connected 
to your computer and its power is switched on. Your modem should be connected 
to the same line as the telephone you want to use. Choose Preferences from the 
Palm Desktop menu in Mac OS X or from the Edit menu in Mac OS 9, and then click 
the Dialing button. From the Dial through pop-up menu, choose Modem Port and 
click OK. (On Mac OS X, the Modem Port option is not available if your version of 
does not enable modem dialing.)

On an address card, click the telephone button next to the telephone number you 
want to dial.

If you have “Confirm number before dialing” selected in Dialing preferences, a 
dialog box opens asking you to confirm that you want to dial the telephone 
number. Otherwise, the telephone dials immediately.

If you change your mind about calling, you can click Cancel to stop dialing and 
release the modem.

If you are dialing through the modem, when dialing is complete, pick up the 
telephone handset, and then click the Release button to release the modem so you 
can talk through the handset.

You can specify the local area code in Dialing preferences so an area code is added 
when necessary. This is especially useful if you travel with your computer.

Click to dial the telephone number

Correct the telephone 
number if necessary

Click to dial the telephoneClick to set Dialing preferences

Click Cancel to stop dialing
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Chapter 3 Working with Address Book
Dialing international numbers
In the Phones section of the address card, place a plus sign (+) before international 
telephone numbers. The international dialing prefix (specified in Dialing 
preferences) is used when dialing the telephone number.

Setting dialing preferences
You can set telephone dialing preferences by choosing Preferences from the Palm 
Desktop menu in Mac OS X or from the Edit menu in Mac OS 9, and then clicking 
the Dialing button.

NOTE When you open Palm Desktop software, it determines the methods that are 
currently available for dialing a telephone and displays them in Dialing preferences. 
If your computer uses a version of Mac OS X and it also has a modem, but Modem 
is not listed in the Dial through pop-up menu, that is because the particular 
combination of operating system and Palm Desktop software on your computer does 
not enable use of a modem.

The “Precede all calls” field can contain any number you must dial, such as 9 for 
an outside line, an access number for a long-distance carrier, or a calling-card 
number. The Long distance prefix field can contain any number you must dial to 
make a long distance call, such as 1.

Click 
Dialing

Choose dialing through the 
modem or speaker

Click to configure 
the modem

Type the area code 
where you are now

Select to see the 
Confirm Dialing 
dialog box

Set outside line 
prefix, if any

Set international prefix, if necessary

Set long distance suffix, if anySelect or deselect as 
necessary if you travel 
with your computer
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Dialing telephone numbers
Configuring your modem for dialing
You can configure your modem by clicking the Configure button in the Dialing 
preferences panel. Proper modem setup depends on your modem and the 
telephone service you have. For information on the correct modem settings, see the 
user guide provided with your modem. For more information on tone or pulse 
dialing, consult your local telephone office.

NOTE When you open Palm Desktop software, it determines the methods that are 
currently available for dialing a telephone and displays them in Dialing preferences. 
If your computer uses a version of Mac OS X and it also has a modem, but Modem 
is not listed in the Dial through pop-up menu, that is because the particular 
combination of operating system and Palm Desktop software on your computer does 
not enable use of a modem.

The following screen shows the Modem Configuration dialog box in Mac OS 9.

Consult your modem user 
guide for proper 
configuration information

Ask your local telephone 
office for information on 
tone or pulse dialing
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Chapter 3 Working with Address Book
Setting Address Book preferences
You can set preferences for address cards by choosing Preferences from the Palm 
Desktop menu in Mac OS X or from the Edit menu in Mac OS 9. In the Preferences 
dialog box, click the Addresses button.

You can change international address formats, or add new ones. To change an 
address format, select the country and click Edit. To add a new address format for 
a country, click Add. The Address Layout dialog box appears.

Click the Addresses button

Select 
preferences 
for Name, 
Address and 
Phone fields

Change labels for 
phone and 
address fields

Choose 
formats for 
address 
fields

Choose which 
address element 
you want in this 
position

Add or change the country 
name as necessary

If you want a 
character 
between address 
elements, type it 
in the box
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CHAPTER 4

Working with Date Book

This chapter explains the basics of working with Date Book.

About Date Book
Date Book gives you a way of viewing your schedule. You can easily move around 
in Date Book to see different days, weeks, or months. In the Date Book, you can do 
the following:

■ Add, change, and move events

■ Create repeating or continuous events

■ Create untimed events

■ Change event durations

■ Add, change, and move To Do List items

■ Set alarms

■ Mark completed tasks

■ Create attachments

New Date Book events and changes in already-existing events are transferred to 
Date Book on your handheld when you perform a HotSync® operation. 

Viewing Date Book
Date Book contains three views: Day, Week, and Month. All three views show you 
events. You can quickly switch between the different views by clicking one of the 
tabs at the right edge of the Date Book window or repeatedly clicking the Date 
Book button on the toolbar.
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Chapter 4 Working with Date Book
Using Day view
To view a single day, click the Day tab in Date Book or choose Date Book from the 
View menu and then choose Day.
 

Using Week view
To view several days at a time, click the Week tab in Date Book or choose Date Book 
from the View menu and then choose Week. Five days appear by default, but you 
can change the number of days that are displayed. 

The white zone 
indicates your work 
hours 

Event Your tasks are listed in 
this area by their priority

A check mark indicates a completed To Do List item Click to move to the 
previous or next day

The colored line 
extends as the day 
progresses and shows 
the current hour

If you have a small 
monitor you can set a 
Date Book preference 
to display more hours 
in the event area

Events

Click to show the previous or next day 
(relative to the current day). Option-
click to show the previous or next week.Click to subtract or add a 

day to the view

The colored line 
extends as the day 
progresses and 
shows the current 
hour

If you have a small monitor you can set 
a Date Book preference to display more 
hours in the events area

A check mark indicates 
a completed To Do List 
item

Your To do List 
items are listed in 
this area
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Adding information to Date Book
Using Month view
To view a month at a time, click the Month tab in Date Book or choose Date Book 
from the View menu and then choose Month.
 

Showing or hiding items in Month view
In Month view, there is not a lot of space to show the text of all the events. To Do 
List items and all events display by default. You may prefer to hide events or To Do 
List items, so that you can easily see the other type of item. You can also hide both 
timed events and To Do List items, so that just untimed events are displayed. 

To hide events, choose Date Book from the View menu and then deselect Show 
Events. To hide To Do List items, choose Date Book from the View menu and then 
deselect Show To Dos. 

These settings do not affect how your events are transferred to your handheld 
during a HotSync operation. All items are transferred and are available on the 
handheld.

Adding information to Date Book
You can create events and To Do List items in any of the Date Book views.

Creating a timed event
A single event is one that occurs once, such as an interview or a product 
demonstration. In the Day and Week Views, you can create an event by double-
clicking the date and time slot you want. You can also choose Event from the Create 
menu or click the New Event button on the toolbar.

To Do List items 
indicated by a bullet

Event indicated 
by a time

Click to move to the 
previous or next month

Untimed event
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Chapter 4 Working with Date Book
In Month view, if you double-click within a day (below the day number), you are 
prompted to create a To Do List item or event. Click the Event button in the dialog 
box and then click OK.

Creating a repeating or continuous event
A repeating event is one that occurs regularly, such as a weekly staff meeting. A 
continuous event is one that spans consecutive days, such as a vacation or 
conference. In the Event dialog box, select Repeat Event. Then choose the interval 
you want from the pop-up menu and type the date of the final event in the series 
in the Until box or choose a date from the calendar pop-up.

Creating an untimed event
Timed events are like appointments with scheduled start and end times. Untimed 
events have no start or end time defined for them. You can use untimed events as 
you would short notes about things to do. An untimed event is indicated by a box 
at the top of a day or days in Day, Week or Month view. You can have multiple 
untimed events per day. When there are two or more untimed events, they are 
listed in the order they were created.

Enter a title

Enter a date or select a 
date from the 
calendar pop-up 

Choose one or two categories 
from the pop-up menus

Click to create 
another event

Choose an interval 
from the list... Enter a date or select a date 

from the calendar pop-up

...or choose More 
Choices to create a 
custom interval
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Adding information to Date Book
NOTE Files that you can use to import holiday information are available in the Palm 
folder. 
 

To create an untimed event, in the Event dialog box, select No Time, then complete 
the description of the event and other options.
 

In the Month view, if you double-click within a day (below the day number), a 
dialog opens asking you whether you want to create a To Do item or event. Click 
the Event button in the dialog box and then click OK.

To duplicate an event, select it, and then choose Duplicate Event from the Edit 
menu.

Untimed event in Day view

Untimed event in Week view

Untimed event in Month view

Click to create another event

Enter a name

Enter a date or select 
a date from the 
calendar pop-up

Choose one or two categories from 
the pop-up menus

Select No Time
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Chapter 4 Working with Date Book
Setting alarms
Alarms are visual reminders of an upcoming meeting or event. There are two 
alarm preferences you can set.

■ Set alarms on new events 

■ Show alarm dialog boxes 

By default, both of these settings are off. To change the default for your events 
choose Preferences from the Palm™ Desktop menu in Mac OS X or from the Edit 
menu in Mac OS 9, and then click Alarms.

NOTE You can set an alarm for an individual event even if the Set alarms on new 
events preference is turned off.

■ To set an alarm for every event you create, select Set alarms on new events.

■ To set alarms to show on your computer as well as on your handheld, select 
Show alarm dialogs.

■ To disable alarms altogether, leave both options unchecked.

When you create or edit an event, you can set an alarm for the event. Select Set 
Alarm in the Event dialog box and change the interval to the amount of time you 
want.
 

Since Date Book is synchronized to your computer’s clock, be sure it is set to the 
correct time.

NOTE You can set an alarm for an untimed event. In this case, the alarm triggers at 
the specified period of minutes, hours, or days before midnight (beginning) of the 
day of the untimed event.

Editing events
Changes you make to events are updated on your handheld the next time you 
perform a HotSync operation.

Changing an event’s date
You can change the date of an event by either dragging the event to another date 
on Week or Month view in Date Book or by double-clicking the event to display 
the Event dialog box. If the event is selected, use the gripper to drag it to another 
date.

Alarm set for reminder to display 
15 minutes before event
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Editing events
Changing an event’s time or duration
You can change the time of an event by dragging the event to another time slot.

You can change the duration of an event by increasing or decreasing the size of the 
eventbox.
 

Or, you can double-click the event near the edge of the event box and then change 
the time or duration in the Event dialog box.

Moving untimed events
To move an untimed event, select the event and drag it to a new date in the Week 
or Month view. You see an outline of the event as you drag it.

Changing a repeating event’s interval
To change the frequency of a repeating event, double-click the event near the edge 
of the box. In the Change Repeating Item dialog box, choose which event(s) you 
want to change and click OK. Then, in the Event dialog box, choose a new interval 
from the Repeat Event pop-up menu.

Drag the event to another 
date

Drag the event to 
another time slot

Drag the border up to 
shorten the event

Drag the border down 
to lengthen the event
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Chapter 4 Working with Date Book
Renaming events
Click in the text area of the event to highlight the text and then start typing over 
the existing text.

Deleting events
To delete an event, select it, and then do one of the following:

■ Press the Delete key

■ Click the Delete button on the toolbar

■ Choose Delete Event from the Edit menu

To delete a repeating event, select it and then choose Delete Event. In the Change 
Repeating Item dialog box, select the event(s) you want to delete and click OK.

The next time you perform a HotSync operation, the event is deleted from your 
handheld.

For information about archiving items you delete from your handheld, see 
“Archiving data you delete from your handheld” in Chapter 12.

Transferring Date Book items to your handheld
Events transfer to the Date Book application on your handheld when you perform 
a HotSync operation. This operation also moves new Date Book events from the 
handheld into the Date Book module in Palm Desktop software and synchronizes 
all other changes made on the handheld or your computer.

The following list shows how data transfers between your computer and your 
handheld:

Palm Desktop software items Transfer to Date Book on handheld as

Event title Event description

Event From and To times, and alarm 
interval

Start and End times, and alarm interval

Categories Not available on your handheld

Events that repeat monthly, on a 
certain day (for example, the civic 
club meeting on the third Tuesday of 
each month)

Repeating events by day of the week or 
month
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Setting Date Book, alarm, and font preferences
Setting Date Book, alarm, and font preferences
You can specify how you want your Date Book views and alarms to display. You 
can also select a font type and size for events.

Choose Preferences from the Palm Desktop menu in Mac OS X or from the Edit 
menu in Mac OS 9.

Events that repeat on more than one 
day of the month (for example, a math 
tutorial on the second Tuesday and 
Wednesday of each month)

Separate repeating events for each day 
indicated

The example would transfer to the handheld 
as a series of repeating events on the 
second Tuesday and a separate series of 
events on the second Wednesday of each 
month. The relationship between the 
Tuesday events and the Wednesday events 
is not maintained.

Private Private

Attachments to events, such as 
addresses or To Do List items

Relationships do not transfer to the 
handheld

The event and each attached item transfer to 
the handheld to their corresponding 
applications on the handheld. The 
relationship between the items does not 
transfer.

File attachments Do not transfer to the handheld

Palm Desktop software items Transfer to Date Book on handheld as

Enter your 
work hours

Choose first day 
of week, 
opening day, US 
or ISO week 
numbers, and 
time interval 
from the pop-up 
menus

Click Date Book
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Chapter 4 Working with Date Book
Set reminder 
interval for alarm 

Click Alarms

Select to display 
alarm dialogs on 
the desktop (not 
for handheld)

Set alarm for new 
events

Choose the font 
type and font 
size for the Date 
Book views

Click Fonts
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CHAPTER 5

Working with Memo Pad

This chapter explains the basics of working with Memo Pad. 

About Memo Pad
You can use Memo Pad to jot down any type of text, for example, your ideas, 
meeting agendas, and phone call memos. 

Memos appear in the Memo Pad application on your handheld after you perform 
a HotSync® operation. 

Creating a memo
Create a memo when you want to store information that needs to be tracked, 
followed up on, or kept in a central location. For example:

■ Family medical histories

■ Meeting action items

■ Serial numbers and registration numbers

■ Directions to places you visit infrequently

Since a memo can contain up to 32KB of information, memos are better for long 
entries than the Comments field in an address card. The capacity of the Comments 
field is only 256 characters.

IMPORTANT Memos on your handheld are limited to 4KB of information. When you 
perform a HotSync operation, a memo that is larger than 4KB is preserved in its 
entirety so long as you do not edit the memo on your handheld. If you edit the memo 
on your handheld, the memo is truncated to 4KB. The next time you perform a 
HotSync operation, the 4KB memo overwrites the larger memo on Palm™ Desktop 
software.
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Chapter 5 Working with Memo Pad
To create a memo, choose Memo from the Create menu or click the New Memo 
button on the toolbar. The memo card appears.

Viewing memos
To see memos in a list, choose Memo List from the View menu or click the View 
Memos on the toolbar. You can view memos one at a time by double-clicking a 
selected memo in the memo list.

For more information about working with memos in list view, for example, sorting 
them, see Chapter 7.

Type the body of the 
memo in this area

Choose one or two categories from 
the Categories pop-up menus

The date and 
time are 
automatically 
filled in

To keep a log, click the 
Timestamp button to 
add the current date and 
time to each additional 
entry you make

Use the paper clip pop-
up menu to attach or 
detach the memo to or 
from an address, To Do 
List item, event, or 
another memo

Use the icon in the title bar to quickly 
attach the memo to another item

Type a title

The paper clip pop-up menu indicates this 
memo is attached to another item
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Browsing memos
Browsing memos
To browse through a series of memo cards, click the  buttons in the memo card 
or press a-Left Arrow to go to the previous memo and a-Right Arrow to go to the 
next memo. The arrows are dimmed when you reach the first card or last card
. 

To browse the memo list, press Up Arrow or Down Arrow or use the scroll bars.

If you have many memos, you may find it useful to browse your memo list by first 
sorting or filtering the memos.

Selecting memos
To change, delete, or duplicate a memo, first select it in the memo list.

Changing memos
After you create a memo you can change the following:

■ The title, date, and time fields and in the body of the memo

■ The categories assigned to the memo 

■ Any attachments

■ The font type and size used in the memo body

Whenever you change a memo, the Modified field is updated. The Modified field 
is preset to be hidden and is available only in the memo list. If you want to display 
the Modified field, choose Columns from the View menu. In the Columns dialog 
box, click next to Modified and then click OK. You see a new column heading at 
the far right side of the list.

See “Setting font preferences” in Chapter 1 to change the font type and font size 
used in memos.

For information about changing attachments to memos, see Chapter 9.

Click to move to the 
next memo card

To select Do this

All memos Choose Select All from the Edit menu

One memo Click the memo

Many memos Press a and click the memos

Consecutive memos Click the first memo and then Shift-click the last memo
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Chapter 5 Working with Memo Pad
Attaching memos
To quickly attach a memo, position the pointer on the icon in the title bar of the 
memo. Drag the memo to any other record, or another memo. You can also make 
an attachment by dragging the memo to the New Address, New To Do, New 
Memo, or New Event button on the toolbar. Another way to attach memos is to use 
the Attach Existing Item palette. For more information see “Attaching one existing 
record to another” in Chapter 9.

NOTE Attached memos are transferred to the Memo Pad application on the 
handheld, but the relationship between a memo and the item it was attached to does 
not transfer.

Deleting memos
You can delete a memo card by doing the following:

■ Clicking the Delete button on the toolbar

■ Choosing Delete Memo from the Edit menu

You can delete a selected memo in the memo list by doing the following:

■ Pressing the Delete key

■ Clicking the Delete button on the toolbar

■ Choosing Delete Memo from the Edit menu 

The next time you perform a HotSync operation, the memo is deleted from your 
handheld.

For information about archiving items you delete from your handheld, see 
“Archiving data you delete from your handheld” in Chapter 12.

Finding memos
You can search through your memos for a word or phrase in any field in a memo. 
You can choose to display the results of your search in a list. For more information 
about using the find feature, see Chapter 8.
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Transferring memos to your handheld
Choose Find from the Locate menu or click the Find button on the toolbar. The Find 
dialog box appears.

If you didn’t select “Display Results in List Window” in the Find dialog box, 
choose Find Again from the Locate menu to go to the next found memo. 

Transferring memos to your handheld
Memos are transferred to the Memo Pad application on your handheld when you 
perform a HotSync operation. This operation also moves new items from the 
Memo Pad application on your handheld into the Memo Pad on Palm Desktop 
software, and synchronizes changes made on either the handheld or computer.

The following list shows the details of the memos data transfer between your 
computer and your handheld:

Type the word or 
phrase you want to 
find

Click the Memos 
button

Click to start searchingClick to select more 
criteria for searching

Click to display 
search results 
in the list view

Palm Desktop software 
items

Transfer to Memo Pad on handheld as

Memo title The first line of the memo

The first line of a memo created on your handheld becomes 
the Memo title on Palm Desktop software.

Memo date and time Do not transfer to the handheld

When a memo is created on the handheld, the memo date 
and time on Palm Desktop software are filled with the time 
of the transfer to the computer.

Categories Category

The first category you assign to a memo is transferred to 
the handheld. The second category does not transfer. See 
“Transferring categories to your handheld” in Chapter 8.

Private Private

Memo body Memo body
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Chapter 5 Working with Memo Pad
Attachments to 
memos, such as 
addresses or To Do List 
items

Relationship does not transfer

The memo and each item attached to it transfer to the 
handheld. The relationship between the items does not 
transfer.

File attachments Do not transfer to the handheld

Palm Desktop software 
items

Transfer to Memo Pad on handheld as
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CHAPTER 6

Working with To Do List

This chapter explains the basics of working with To Do List to track the tasks you 
need to do.

About To Do List
Using the To Do List module, you can keep track of tasks you need to accomplish. 
You can set completion dates for these items so they are displayed with your daily 
schedule in Date Book. You can also see them in a to-do list and organize that list 
by date, category, or priority. To Do List items can repeat at specific intervals, and 
you can assign one or two categories to each item.

After a HotSync® operation, To Do List items you create in Palm™ Desktop 
software appear in To Do List on your handheld. To Do List items with due dates 
do not appear in the Date Book application on the handheld. If the Date Book on 
your handheld has Agenda View, however, you can view events and To Do List 
items together. (Agenda View is available on handhelds using Palm OS® software 
version 3.5 or later.) 

Adding To Do List items
To add a new item, choose To Do from the Create menu or click the New To Do 
button on the toolbar.

Type what you need to do

Choose one or two categories 
from the pop-up menu

Choose a priority
Click when an item 
is completed

Click to add 
another item

Click to show the 
item in Date Book if 
it’s uncompleted 
after due date

Enter the date 
the item is due

Enter a different date or 
select a date from the 
calendar pop-up
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Chapter 6 Working with To Do List
Adding repeating To Do List items
Some To do List items happen on a regular basis. To repeat an item on another day 
or another week, select Repeat To Do, and then choose a repeat interval from the 
pop-up menu that appears.

If the repeat interval that you need is not available in the pop-up menu, choose 
More Choices from the pop-up menu, then enter the appropriate information.

Adding unscheduled To Do List items
To Do List items don’t need to have a specific due date. You can create unscheduled 
items whenever you think of something you need to do, but you don’t know when 
you will be able to do it. Make an item unscheduled by deselecting the Schedule To 

Choose an interval 
from the list

Select Repeat To Do

Type a date or 
choose a date from 
the calendar pop-up 
menu

Choose More Choices from 
the pop-up menu, then 
select the repeat interval
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Adding To Do List items
Do check box in the To Do dialog box. The item does not appear in any of the Date 
Book views and has no reminder, but it appears in the To Do List. 

When you are ready to set a date for an unscheduled item, drag it from the To Do 
List to a day in the daily or weekly calendars. The item now has a due date, and 
appears in the Date Book views.

Adding To Do List items from Date Book
You can add To Do List items while you’re in Date Book. When in Day or Week 
view, create a new To Do List item by double-clicking a blank portion of the To Do 
area. The To Do area is on the right of the Day view, and at the bottom of the Week 
view.

When in Month view, create a new To Do List item by double-clicking a day. Click 
To Do in the dialog box that appears, and then click OK.

The item you create appears as a bulleted item on that day in Month view.

Unscheduled item

Double-click to 
create a new item

Day view

Week view

Double-click to 
create a new item

Click to create a To Do 
List item
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Chapter 6 Working with To Do List
Viewing To Do List items
To see your To Do List items in a list, choose To Do List from the View menu or click 
the To Dos button on the toolbar.

Two special views of your To Do List items are available by default. Choose This 
Week-Uncompleted or Today-Uncompleted from the View pop-up menu. The 
uncompleted items display.

For information about selecting items, or groups of items, see Chapter 7.

Editing To Do List items
Before you can delete, duplicate, or change an item, you must select it. Show the 
To Do List, then click the item you want to select. Double-click to open the To Do 
List dialog box.

In the Date Book, you can also click a To Do List item to select it, and double-click 
to open it.

Changes to items are updated on your handheld the next time you perform a 
HotSync operation.

Renaming To Do List items
You can rename an item whenever you like. Double-click the item in To Do List or 
in one of the Date Book views, and then type the new name. Click OK.

Choose This Week-Uncompleted 
or Today-Uncompleted

Selected items

Drag to highlight, then type the new item name
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Editing To Do List items
The new name appears on the corresponding To Do List item on your handheld the 
next time you perform a HotSync operation.

Changing dates of To Do List items
You can change the date of a To Do List item at any time. In the To Do dialog box 
type a new date, or choose a date from the calendar pop-up.

You can also quickly change the day an item is to be done in Date Book’s Week or 
Month view by dragging the item from its current date to a new one.

Setting reminders for To Do List items
You can be reminded of upcoming To Do List items. To set reminders, create a new 
To Do List item or double-click an existing one. In the To Do dialog box, select the 
Remind check box. Type the number of days before the item due date you want to 
be reminded. For example, if you have an item due on Friday, and you want a 
reminder two days before that, on Wednesday, type 2 in the Remind box.

NOTE Reminders for To Do List items do not transfer to your handheld. To set an 
alarm for your handheld from the computer, create an event instead of a To Do List 
item.

Type a date...

... or click the calendar pop-
up and double-click a date

Select to show the 
item in Date Book 
before its due date

Enter the number of days 
before the due date to be 
reminded
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Chapter 6 Working with To Do List
Setting priorities for To Do List items
To prioritize To Do List items, in the To Do dialog box, choose a priority from the 
Priority pop-up menu.

The color of the box next to a item indicates the item’s priority.

When you sort items, uncompleted items appear first, followed by the completed 
items. Within those two groups the items sort by priority, from highest to lowest.

After a HotSync operation, the item appears in the To Do List application on your 
handheld with the priorities numbered.

Changing the interval of repeating To Do List items
You can change how often an item repeats in Date Book. In the To Do dialog box, 
choose a new interval from the Repeat Task pop-up menu. You may select the end 
date and change or delete it entirely. If you delete the end date, the item repeats 
indefinitely.

Adding or changing categories for To Do List items
To change a To Do List item’s category, click the left Category pop-up menu in the 
To Do dialog box, then choose a different category. If you would like to add a 
second category selection or change an existing one, click the right Category pop-
up menu and choose a category. The second category is not transferred to your 
handheld during a HotSync operation. If the item has a category selected and you 
want to remove the category, click the Category pop-up menu and choose None.

Palm Desktop 
priority

Palm Desktop 
color

Handheld 
priority

Highest Red 1

High Orange 2

Medium Gray 3

Low Green 4

Lowest Blue 5

Choose a priority
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Marking completed To Do List items
Categories are a useful way of organizing your To Do List items, providing more 
flexibility when you view or print your To Do List. For example, you could choose 
to view or print only items that relate to customers. You can add categories to fit 
your needs and even assign colors to categories.

Moving To Do List items in Date Book
To help you see at a glance what you need to do, you can rearrange the listings of 
your items in the Day or Week views within Date Book. Click the item you want to 
move and drag it to its new position in the list.

You can also move a To Do List item from one date to another in Week or Month 
view by dragging the item from its current date to a new one.

Marking completed To Do List items
After you finish an item, you can mark it as being completed. This is useful when 
sorting To Do List items—you can separate items which have been completed from 
those which haven’t.

To mark an item as completed, select the Completed check box in the To Do dialog 
box. You can also select the box next to an item in To Do List, or in the Day or Week 
views in Date Book.

Choose a new category

Mark item 
as 
completed

To Do List

Day view

To Do dialog box

Week view
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Chapter 6 Working with To Do List
After you mark items as completed, you can sort the completed and uncompleted 
tasks in Day or Week view in Date Book by clicking the To Do label. The 
uncompleted items appear at the top of the list, and the completed items move to 
the bottom. Within those two groups, the items are sorted by priority, from highest 
to lowest.

The next time you perform a HotSync operation, the items are updated on your 
handheld.

Deleting To Do List items
To delete an item, click it in the To Do List, and then choose Delete from the Edit 
menu. You can also click the Delete button on the toolbar. Confirm your choice by 
clicking Delete when the dialog box appears. The next time you perform a HotSync 
operation, this item is deleted from your handheld.

You can also click the Delete button in the To Do dialog box to delete existing items.

For more information about archiving items you delete from your handheld, see 
“Archiving data you delete from your handheld” in Chapter 12.

Transferring To Do List items to your handheld
To Do List items are transferred to the To Do List application on your handheld 
when you perform a HotSync operation. This operation also moves new items 
from the To Do List on your handheld into the To Do List in Palm Desktop 
software, and synchronizes changes made in either the handheld or your 
computer.

Click to sort completed 
and uncompleted items

Day view

Week view
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Transferring To Do List items to your handheld
The following list shows the details of the data transfer between your computer 
and your handheld:

Palm Desktop software items Transfer to To Do List on handheld as

Item text Item text

Priority Priority

Lowest priority in Palm Desktop software transfers to 
priority 5 on the handheld; highest priority transfers as 
priority 1.

Completed check box Completed check box

Item date Date Due field

Carry Over After Due check 
box

Does not transfer to the handheld

Items remain in the To Do List on the handheld 
regardless of their due dates.

Repeat To Do check box A new To Do List item

After the current task is marked complete, a HotSync 
operation transfers the next instance of the task to the 
handheld.

Categories Category

The first category you assign to the item is transferred 
to the handheld. The second category does not 
transfer. See “Transferring categories to your 
handheld” in Chapter 8.

To Do List items created in 
Date Book

To Do List items

To Do List items with due dates do not appear in the 
Date Book application on the handheld. If the Date 
Book on your handheld has Agenda View, however, 
you can view events and To Do List items together. 
(Agenda View is available on handhelds using Palm 
OS software version 3.5 or later.) 

Remind check box Does not transfer to the handheld

An item created with a reminder setting transfers to 
the handheld, but no alarm is set on the handheld.

Private Private

Attachments, such as 
memos, events, or 
addresses

Relationships do not transfer to the handheld

The To Do List item and each attached item transfer to 
the handheld to their corresponding applications. The 
relationship between the items does not transfer.

File attachments Do not transfer to the handheld
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Chapter 6 Working with To Do List
Setting preferences for To Do List items
You can set preferences for default To Do List item priorities, list fonts, and list font 
sizes, by choosing Preferences from the Palm Desktop menu in Mac OS X or from 
the Edit menu in Mac OS 9.

Click Fonts to set font and font size information for list views.

Click General

Choose the 
default 
priority setting 
for new items

Click Fonts

Select a font 
and size for the 
list view
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CHAPTER 7

Working with Lists

This chapter explains the basics of working with list views for addresses, memos, 
and To Do List items.

About list views
When you view lists of your addresses, memos, and To Do List items, you see the 
information in rows and columns. Each row represents a record. Each column 
represents a field used for typing and storing information about one of these 
records. You can double-click a record at any time to view or change it.
.

NOTE A list view is not available for Date Book information (events).

Memo list

To Do List

Address list
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Chapter 7 Working with Lists
Viewing a list
To display one of the list views, choose Address List, Memo List, or To Do List from 
the View menu, or click the Addresses, Memos, or To Dos buttons on the toolbar.

Viewing selected records
You can change a list to display only the records you want. By creating a filter, you 
can show certain records in a list while hiding others. You can type your own 
special criteria for the filter, or use preset choices. After you’ve done that, you can 
view and print only the special list of records you’ve created.

You create a filtered list by clicking the  button next to a column heading and then 
choosing a filter from the pop-up menu. For example, you can show only your 
high-priority To Do List items.

You can have more than one filter in effect at a time. For example, in your Address 
list, you could show just the customers in Illinois by choosing Customers from the 
Categories pop-up menu, and Illinois from the State pop-up menu.

Addresses Memos To Dos

Choose the filter you want

The list displays only 
the items you specify

Click to display a pop-up menu
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Viewing a list
Custom filters
If you don’t see the filter you’d like in a pop-up menu, you can create your own 
custom filter. Choose Custom Filter from the pop-up menu, then choose the search 
option which best fits your needs.

NOTE Filters are not case-sensitive.

To display fields that Choose Example

Contain the filter text Contains To find all names with “son” in them, type 
“son.” “Thompson,” “Gleason,” and 
“Sonders” are found.

Start with the filter text Starts With To find all the names that start with “son,” 
type “son.” “Sonders” is found, but not 
“Thompson.”

End with the filter text Ends With To find all the names that end with “son,” 
type “son.” “Thompson” and “Gleason” 
are found, but not “Sonders.”

Are exactly the filter 
text

Is To find only the name “Sonders”, type 
“sonders.” Only those addresses with this 
name are found, but not “Thompson” or 
“Gleason.”

Do not exactly match 
the filter text

Is Not To find all addresses except those with the 
name “Sonders,” type “sonders.”

Do not contain the filter 
text

Doesn’t 
Contain

To find all addresses except those with 
“son” in them, type “son.” “Miller,” 
“Jones,” and “Smith” are found, but not 
“Thompson” or “Sonders.”

Type the filter text

Click to use more filters

Choose the field you want to use 
for your filter

Choose a search option
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Chapter 7 Working with Lists
You can also use the Find feature to view selected records. For more information, 
see Chapter 8.

NOTE After creating filters you can save the resulting view if you think you’ll be 
using it again. See “Memorizing views of selected data” in this chapter for more 
information.

Removing filters
You can easily remove all filters to see all records by clicking Show All in the upper-
right corner of the list window. Or choose All Addresses, All To Dos, or All Memos 
from the View pop-up menu in the upper-left corner of the window.

You can also remove a filter from a single field. Find the field that has the filter you 
want to remove (scroll left or right if necessary), click the  at the top of the column 
to see the filter pop-up menu, and choose No Filter. The filter is removed from that 
field, but it remains available in the filter pop-up menu in case you want to apply 
it again.

NOTE If you remove a filter from one field, filters on any other fields remain in effect 
until you remove them too.

Are blank Is Empty Choose to find all addresses with a blank 
name field.

Are not blank Is not Empty Choose to find all addresses with a 
completed name field.

To display fields that Choose Example

...or click the Show All button

Choose All Addresses (or All Memos or 
All To Dos) from the View pop-up menu 
to see all items...
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Sorting lists
Sorting lists
To sort a list by more than one column, choose Sort from the View menu. The Sort 
dialog box opens.

Select the primary and secondary sort fields from the pop-up menus. The lists are 
sorted first by the primary field, then by the secondary field.

For example, if you’re working with the Address list and you want it sorted by 
company, choose Company as the primary sort. If you want the list further sorted 
by full name within each company, choose Full Name as the secondary sort.

If you want to sort hidden columns, select the Show All Fields check box. For more 
information, see “Selecting columns to display in a list”in this chapter.

When your data is sorted, the field names you sorted by appear highlighted. A 
dotted underline appears beneath the field that is the secondary sort.

You can also sort using either of two shortcuts:

■ Click the field name

Click the name of the field by which you want to sort. If you want a secondary 
sort, press the Shift key and click that field name. 

■ Choose Sort from the pop-up menu

Click the  button at the top of the column next to the name of the field by 
which you want your data sorted, then choose Sort from the pop-up menu. A 
primary sort is performed on that field. If another field had previously been the 
primary sort, it becomes the secondary sort field.

Select the primary sort field
Select the secondary sort field, if any

Select to reveal any hidden fields

Shift-click for a secondary sort

Click for a primary sort
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Chapter 7 Working with Lists
Selecting columns to display in a list
You can choose which columns you want to display in a list view. You can also 
change the order in which the columns display.

First, display an address list, memo list, or To Do List. Then choose Columns from 
the View menu.
.

You can also open the Columns dialog box by double-clicking a column heading 
(this action also sorts records by that column).

Resizing and reordering columns
You can resize the width of the columns and reorder the columns in a list.

To reorder columns, click a column name and drag it to the left or right just beyond 
the point where you want it to be. You see a pointer as you drag.

To resize a column, drag the right border of its column heading.

Click the check box to the left 
of a column name to deselect 
and hide it

Drag a column name up or down 
to change its order in the list view

Double-click a column heading

To resize a column, drag 
its right border

To move a column, drag the 
column name left or right
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Memorizing views of selected data
Memorizing views of selected data
After you’ve specified filters to view only portions of your information, you can 
save this subset as a view. You can create as many views as you like.

Choose Memorize View from the View pop-up menu in the upper-left corner of the 
list window.

Enter a name for the view, and select the memorize options you want.

After you name a view, it appears in the View pop-up menu. It also appears in the 
View menu in the menu bar, so you can see this saved view at any time.

There are two To Do List views in the View pop-up menu already created for you: 
This Week-Uncompleted and Today-Uncompleted. By choosing either of these two 
views you can easily see what tasks you still need to accomplish.

Select To remember

Current Sort Data sorted as it is now

Column Arrangement Current column order and which columns are visible

Window Positions Current window positions and window size

Use filters to select the data to 
display, and then choose Memorize 
View from the View pop-up menu

Type view name
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Chapter 7 Working with Lists
Changing memorized views
To change a memorized view temporarily, choose it from the View pop-up menu, 
then create additional filters or change existing ones. After you change the current 
view, the word “modified” appears to the right of the View pop-up menu.

■ If you want to save this new view, choose Memorize View from the View pop-
up menu, then enter a name for this view in the Memorize View dialog box.

■ If you want to re-use the current view name, enter it if it does not already 
appear, click OK, and then click Replace in the alert box.

Deleting memorized views
To delete a memorized view, choose it from the View pop-up menu, then choose 
Delete View.
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CHAPTER 8

Finding and Categorizing Information

This chapter explains the basics of finding and categorizing information. 

Going to a specific date
You can go to a specific date by choosing Go To Date from the Locate menu or by 
clicking the Go To button on the toolbar. 

When you specify a date in the text box, you can type it in the following formats:

■ Long format: month,day,year 

■ Short format: mm/dd/yy, mm dd yy, or mm.dd.yy

In the Go To Date dialog box, press a-Left Arrow to display the previous month 
and a-Right Arrow to display the next month. Press the Minus key to move the 
highlight to the previous day and the Plus key to move the highlight to the next 
day.

To go to the current date, choose Today from the Locate menu or click the Today 
button on the toolbar.

...Or type a new date

Click to display the 
previous or next month

Selected date is 
highlighted

Click to select a new date...

Click to move to 
the selected date

Current date 
appears in boldface
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Chapter 8 Finding and Categorizing Information
Finding text
You can search one module at a time or all of them for information. Choose Find 
from the Locate menu or click the Find button on the toolbar. The Find dialog box 
appears.

To repeat the search, choose Find Again from the Locate menu.

Finding addresses quickly
If you are searching for addresses and want to see the names of the Address Book 
items in the Find dialog box, deselect Display Results in List Window. 

When you do this type of search, only the Name, Company, and Nickname fields 
are checked, and only text that starts with what you type is found.

Setting search options
When you click More Choices in the Find dialog box, you see another dialog box 
with options that vary according to the module you selected. You can use these 
options to narrow your search.

Enter the word or phrase
you want to find

Click the button for the 
module you want to search

Click to start searchingClick to select more specific 
criteria for searching

Click to display the entire 
set of found items in the 
module’s list window

Deselect this option so that 
the found records are listed in 
the Find dialog box

Click Addresses 

Enter the initials or first few 
characters of the name or 
company

The found records 
are displayed here

Click to display the address 
card for the selected record
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Displaying recent records
The content of the right side of the dialog box changes according to what is selected 
in the left side of the dialog box. For example, if you select Memos, and then select 
the Memo Title field, the dialog box looks similar to the following illustration.
 

To repeat the search, choose Find Again from the Locate menu.

NOTE Doing a search using this dialog box is similar to using the Custom Filter 
option in the pop-up menus in the address list, memo list, and To Do list. You can save 
the search criteria when you memorize a view. See Chapter 7 for more information.

Displaying recent records
The Recent submenu lists the last 20 records you created, selected, or viewed. To 
display an item you recently used, choose Recent from the Locate menu and then 
choose an item from the submenu. 

Finding frequently used records
If you frequently search for a certain item, such as a customer account or memo on 
a project, you can put its name in the Locate menu. The items are listed in the order 
that you add them to the menu. You can add up to 20 items. 

NOTE If you frequently look up information about certain people, add their 
addresses to the Instant Palm™ Desktop menu, so you can access the information 
quickly. See Chapter 13 for more information.

Click to return to the first 
Find dialog box

Select the field(s) you 
want to search

Click to display other 
text search filters

Click to show or hide additional 
boxes for typing search text

Click to start searching

Type the text you want to find

If no items are found, a 
message appears here

If you have selected more than 
one field, choose an option 
from the pop-up menu
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Chapter 8 Finding and Categorizing Information
To add an item to the Locate menu, select the record, and then choose Add To Menu 
from the Locate menu. To remove a record from the Locate menu, choose Remove 
from the Locate menu. Select the record you want to remove and click Remove. 

Working with categories
You can assign records and other data to categories. Categories are color-coded so 
you can easily distinguish groups of records, such as projects or vendors. When 
records are assigned a category, you can easily search for different groups of items 
and quickly apply filters when you are viewing records in a list.

Assigning records to categories
Create or select a record. In the dialog box or information card, choose a category 
from one or both of the Categories pop-up menus. 

To assign several records to a category at one time, select the records by a-clicking 
them or by holding down the Shift key and selecting the first and last item in a 
block. Then choose Categories from the Edit menu and a category from the 
submenu. If an record already has been assigned a category, the new category is 
displayed in the second Categories pop-up menu.

NOTE To remove a record from a category, choose None from the Categories pop-up 
menu.

Items you add to 
the Locate menu 
are listed here

Categories pop-up 
menu in a memo
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Working with categories
Creating categories
There are several preset categories, such as Customers and Friends/Family. You 
can create your own categories.

Create or select a record and then choose Edit Categories from the Categories pop-
up menu.

NOTE To create categories when an item is not selected, choose Categories from the 
Edit menu and then Edit Categories from the submenu.

Transferring categories to your handheld
Categories are transferred to your handheld when you perform a HotSync® 
operation. This operation also moves new categories from the handheld 
applications into the Palm Desktop category list.

The handheld supports 15 separate categories plus the category “Unfiled” for the 
To Do List, Address Book, and Memo Pad (Date Book categories are not available 
on the handheld). When transferred to Palm Desktop software, the categories are 
combined into a single list. Categories with no items assigned to them are not 
transferred to your handheld. Categories for events are not available on your 
handheld.

To best use categories between your handheld and your computer, use the first 
category in Palm Desktop software to identify how you want the items grouped 
when they are transferred to the handheld. Then use the second category to 
indicate the more refined groups you may want to use for searching and printing 
features in Palm Desktop software.

If you move an item on your handheld to a different category, and then perform a 
HotSync operation, the item is moved to the new category in Palm Desktop 
software.

Click to add a category
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Chapter 8 Finding and Categorizing Information
The following list shows the details of the data transfer for categories between your 
computer and your handheld:

Changing category name or color
You can change the name of a category, including the preset categories, or the color 
you’ve assigned to it. 

Choose Categories from the Edit menu, and then Edit Categories from the 
submenu. In the Edit Categories dialog box, select the category you want to edit 
and click Edit. The Categories dialog box appears. The currently selected Decor 
affects the colors you see in the dialog box.

Changing a category name affects all of the items assigned to that category. 

Deleting categories
You can delete categories you don’t use, including the preset categories. In the Edit 
Categories dialog box, select the category you want to delete and click Delete.

Palm Desktop software 
categories

Transfer to handheld as

First category Category

Each application on the handheld can store up to 15 
categories. If more categories with records assigned to 
them are found in Palm Desktop software, the records in 
the 16th and later categories are placed in the Unfiled 
category on the handheld.

Second category Does not transfer to the handheld

Category colors Do not transfer to the handheld

Click to select another color. 
If you don’t select a color, 
black will be used, which is 
represented by the gray 
block.

Type a new name

Current color 
is highlighted
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CHAPTER 9

Working with Attachments

Attachments are connections between related Palm™ Desktop records, and 
between records and files in other applications on your computer. Attachments 
help you access information where and when you need it. For example, you can 
create a To Do List item to phone a client and attach this item to the client’s address 
card so that the information you need about the client will be available during the 
phone call. Attachments can be created automatically for you, or you can create 
attachments on your own.

When an item has attachments, a paper clip pop-up menu appears next to it. 

The number next to the paper clip pop-up menu shows how many attachments the 
item has.

NOTE Only attachments connected to events are printed.

Transferring attachments to your handheld
Attached memos, events, addresses, and To Do List items are transferred to the 
corresponding application on the handheld when you perform a HotSync® 
operation, but the relationship between the items does not transfer.

For example, let’s say you create an address for a new customer. At the same time 
you schedule a visit to the customer in Date Book and a create a memo describing 
the sales information you want to bring to the customer. You attach the event and 
memo to the address card for the customer. 
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Chapter 9 Working with Attachments
When you perform a HotSync operation, the address, memo, and event transfer to 
the corresponding applications on the handheld. Looking up the customer in the 
Address Book in the handheld, you see the customer ’s information. To see the 
memo and event, you must look them up in the Memo Pad and Date Book 
applications respectively. The relationship between the different information types 
is not available between the handheld applications.

If, on your handheld, you add a note to an Address Book, Date Book, or To Do List 
item, the information appears as an attached memo in Palm Desktop software 
when you perform a HotSync operation. The attached memo appears with the title 
“Handheld Note: XXX.”

Automatic attachments
When you create a new record in Palm Desktop software, if there are addresses that 
match the record’s content, you are prompted to attach the addresses to the new 
record. For example, if you created an event called “Lunch with Heidi” and your 
Address Book includes Heidi Shaw and Heidi Lee, the Auto-Attachments dialog 
box opens.

If you don’t want to see this dialog box, you can change the way attachments are 
created. For more information, see “Setting attachment preferences”in this chapter.

Creating attachments
You create an attachment when you want to associate one record with another, or 
a record to a file on your computer.

Attaching one existing record to another
The easiest way to create an attachment is to drag an existing record onto another 
record using the icon in its title bar. For example, you can drag an address card onto 
an event to attach the two to each other.

Select the 
item or items 
you want to 
attach to the 
record
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Creating attachments
There are five ways to attach an existing item to another existing item:

■ Locate both records, arrange the windows so both are visible, then drag and 
drop one onto the other. If you want to attach two records of the same type, such 
as a To Do List item to another To Do List item in the task area in Date Book, 
press Option as you drag.

■ Locate the first record, choose Existing Item from the Attach to submenu, locate 
the second record, then drag from the Attach Existing Item palette onto the 
second item. This method is often easier to use because you manipulate the 
windows less.

■ Locate the first record, choose Attach to from the Create menu, and then choose 
Existing Item. The Attach Existing Item dialog box appears.

This method allows you to create an attachment in separate steps; you can open 
the window that contains the second record after you choose the first item and 
the Existing Item option.

■ Select an existing record, choose Attach from the Create menu, and then choose 
Instant Attach. If there is an address record that matches the record, it is offered 
as an attachment.

Click the icon in 
the title bar. Wait 
for the icon to 
darken, and then 
drag the record to 
the one you want 
to attach it to

Release the 
mouse button to 
create the 
attachment

You can drag the gripper in 
this dialog box to create the 
attachment
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Chapter 9 Working with Attachments
■ Locate the first record, click and hold the paper clip pop-up menu , select the 
Attach To operation, and then the Existing Item submenu.

Attaching new records to existing records
To create a new record and automatically attach it to an existing record, select the 
existing record and choose Attach to from the Create menu (or from the paper clip 
pop-up menu). Then choose New Event, New To Do, New Address, New Memo, 
or File. Or, drag the existing item to the New Event, New To Do, New Address, or 
New Memo button on the toolbar.

The new item is named by default. For example, if you have an Address Book item 
named Susan Shaw and you select that item and choose New To Do from the 
Attach to submenu, the To Do List item is automatically named “Call Susan Shaw.” 
You can type over the name if you want to change it. You can also drag an address 
record onto the events area of Date Book to automatically create an event named 
“Meeting with” followed by the person’s name.

When you finish creating the new record, it is attached to the existing record you 
selected.

...to display attachment 
options

Click and hold down the 
paper clip pop-up menu...

Indicates the number of 
attachments this record has
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Creating attachments
You can create To Do List items related to existing events in Date Book. Just drag 
the event to the To Do List area of the appropriate day, and a new To Do List item 
attached to the event is created. You can type over the default name if you want to 
change it.

You can also create an event related to a To Do List item by dragging an item to the 
events area of the calendar.

Attaching files to a record
To attach any file on your computer to a record, select the record, choose Attach to 
from the Create menu, and then choose File. Find the file you want, and then click 
Open.

After you attach a file to a record, the filename appears in the record’s paper clip 
pop-up menu. When you select the file from the record’s paper clip pop-up menu, 
the application the file was created in launches, if necessary, and the file is opened.

Drag the event 
to the To Dos 
area

A To Do List 
item attached 
to the event is 
created

To Do 
List 
area

Select the file you 
want to attach
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Chapter 9 Working with Attachments
You can also attach a word processing document to an Address Book item to have 
information about the person copied into the document automatically. See 
Chapter 3 for more information.

NOTE Attached files are not transferred to your handheld in a HotSync operation. 
The existing record is transferred, but the file attached to it is not.

Viewing attached records
Click a record’s paper clip pop-up menu to see a list of the items attached to it. If 
there is more than one attachment, they are organized in submenus. Click the 
appropriate submenu to open an attachment. 

Detaching or deleting records
To detach a record or to delete an attached record, click a record’s paper clip pop-
up menu and choose Detach. The Detach dialog box appears.

NOTE The next time you perform a HotSync operation, the item you deleted is 
deleted from your handheld. Detached items are not deleted from your handheld.

Click to see attachments

Click to open an 
attachment

Click to delete the 
selected records 

Select one or more 
attached records to 
detach or to delete

Click to detach 
the selected 
records from 
the main 
record
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Setting attachment preferences
Setting attachment preferences
You can set preferences for how attachments to addresses are created. 

Choose Preferences from the Palm Desktop menu in Mac OS X or from the Edit 
menu in Mac OS 9. 

Does not attach addresses automatically

Automatically attaches an address if 
there is only one match; asks for 
confirmation if there is more than one 
match

Attaches all 
addresses 
that match 
without 
asking for 
confirmation

Always confirms attachments with 
you before attaching, even if there 
is only one possible match

Click General
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CHAPTER 10

Importing and Exporting Data

This chapter explains the basics of importing and exporting data. 

Migrating data from Claris Organizer
To convert a Claris Organizer file to Palm™ Desktop format, all you need to do is 
open the file in Palm Desktop software. To have the Claris Organizer data be 
included in the Palm Desktop data file that is synchronized with your handheld, 
follow these steps:

1. Make a backup copy of your Claris Organizer data file.

2. Open Palm Desktop software.

3. Verify that the file you use to synchronize with your handheld is open.

The name of the data file appears in the title bar of the Palm Desktop software 
windows and this same username appears in the user pop-up menu on the 
toolbar.

4. Choose Merge from the File menu.

5. Select your Claris Organizer data file.

6. Click Open.

Your Claris Organizer data has been merged into your data file. Perform a 
HotSync® operation to transfer this information to your handheld.

The name of the current data file appears 
in the title bar of each window
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Chapter 10 Importing and Exporting Data
Importing data
You can import data from any of the following PIM (personal information 
manager) products. 

To import data from PIM product files, you must export and save the entire file in 
tab-delimited text format first. You can import fields from TouchBase Pro, 
DateBook Pro, DayMaker, and QuickDex files in the proper order. You might have 
to adjust the field order of other PIM product files you import.

This imported data is transferred to your handheld when you perform a HotSync 
operation.

You can import data from other applications as long as you can export the data 
from the application as a tab-delimited text file. For example, you can import data 
from an Microsoft Excel workbook file in which you keep names and addresses.

You can also import data from a FileMaker Pro database or a ClarisWorks database. 
In FileMaker Pro, be sure to export the database to the Tab-Separated Text file type. 
In ClarisWorks, be sure to save the database in ASCII text format and give it a 
different name so you don’t overwrite the original file.

You can import data from a Newton using Newton Operating System 1.0. Simply 
use the Newton Connection Kit to export data from the Newton Names File, Date 
Book Calendar file, and Notepad and then import the resulting files into Palm 
Desktop software. The Newton Connection Kit does not work with Newton 
Operating System 2.0.

■ Address Book Plus ■ Now Contact

■ DateBook Pro ■ Now Up-to-Date

■ DayMaker ■ QuickDex

■ DynoDex ■ TouchBase Pro

■ Meeting Maker ■ vCard/vCal 
compatible PIMs
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Importing data
To import a file, export a text file from the other product and then choose Import 
from the File menu in Palm Desktop software.

The Import dialog box appears. In the Import dialog box, you can scan the data in 
the file and remap the way the fields are imported. Your screen may look different 
depending on the product you exported from. 

Click to import the 
selected file

Select the 
file you want 
to import

Use the Scan Data 
buttons to browse 
through the actual 
information in the 
file.

These fields are set automatically for some file types. 
If you are importing another file type, set Fields 
appropriately and set Delimiters to Tab & Return.

To omit a field, click the arrow next to it (this 
deselects the arrow and leaves a dotted line).

Palm 
Desktop 
fields

Import 
file fields
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Chapter 10 Importing and Exporting Data
Use the Scan Data buttons to browse through the actual data in the file and change 
the way the fields map, if necessary.

vCard and vCal files
Dragging a vCard file into Address Book or a vCal file into Date Book 
automatically creates one or more new records in the module, depending on how 
many records the vCard or vCal file contains. You can also import vCard or vCal 
files by choosing Import from the File menu and selecting and opening the files.

Exporting data
You can export data from Palm Desktop software so you can use the data in other 
applications. Check the documentation for the application you want to import the 
data into to find out what order the fields should be in and what delimiters you 
should use.

Exporting Address Book items as a vCard file
vCard enables you to export the data in one or more Address Book items in a 
standard format. A vCard file (extension: VCF) can be easily imported into any 
application that supports the vCard standard.

Exporting Date Book events as a vCal file
vCal enables you to export one or more Date Book events in a standard format. A 
vCal file (extension: VCS) can be easily imported into any application that 
supports vCal.

Drag a field so 
that the field 
name matches 
the correct field 
information
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Exporting data
Exporting data from Palm Desktop software
To export a subset of records from a module, open the module’s list view and filter 
the list to display only the records you want to export. Choose Export from the File 
menu. The Export dialog box appears.

If you want to do a custom export, choose Custom for Column Options, then select 
the fields and the field order in the dialog box. This option is not valid for vCard 
or vCal files. When you are finished, click OK to close the Column Options dialog 
box.

Choose the delimiters 
required by the other 
application

Select the module you want 
to export records from

Specify whether 
you want to export 
all records from the 
module or only the 
ones displayed in 
the list window

Choose if you want 
to select the fields 
and the field order 
in the dialog box 
itself (see below)

To omit a field, deselect 
the arrow next to it

To change the field order, drag 
field names to different positions
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Chapter 10 Importing and Exporting Data
Select the format of the exported file. You may choose from the following formats:

Dragging records outside Palm Desktop software to copy them
You can drag a record from a list view to the desktop or to another application, 
such as Microsoft Word or Excel. This action creates a copy of the record. Choose 
the list view or Date Book view you want from the View menu, and then position 
the mouse pointer on the record you want to copy. Drag the record to the desktop 
or to another open application.

You can also copy an open Address Book item or memo. Click the icon in the title 
bar of the dialog box and hold until the icon darkens. Drag the icon to the desktop 
or to another application.

NOTE This operation is not the same as dragging a record from one module to 
another within Palm Desktop software, which creates an attachment.

The results vary depending on the kind of record you drag and the location you 
drag it to.

*If the record is copied as text and you want a vCard or vCal file, try dragging the 
record to the desktop first, and then dragging it to the application.

This option Exports data in this format

Tab and Return Tab-delimited file in ASCII (text) format

Palm Desktop An archive file, which varies depending on the module you 
export from

vCard VCF format, available only for Address Book items

vCal VCS format, available only for Date Book events

If you drag To Mac desktop To an application

Address Book item vCard file (VCF) vCard file (if supported by the 
application); otherwise, the entire 
record as text*

Date Book event vCal file (VCS) vCal file (if supported by the 
application); otherwise, the 
description of the event as text*

To Do List item text clipping text

Memo text clipping text
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CHAPTER 11

Printing

This chapter explains the basics of printing. For information on double-sided 
printing, see Appendix A.

About printing
You can print:

■ Date Book views

■ Day planner pages

■ To-do lists

■ Address lists

■ Address books

■ Envelopes

■ Mailing and return address labels

■ Fax cover sheets

■ Memos

You can also create or customize printing layouts for your specific needs.

First, perform a HotSync® operation to transfer the information from the handheld 
to your computer, then print as described in these topics.

NOTE Decors change the onscreen appearance only. They have no effect on printing.
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Chapter 11 Printing
Selecting records
When printing addresses, To Do List items, or memos, you can choose between 
printing all the information in your file, or only some of it.

There are four ways you can select which items you want to print:

■ Creating a filter

■ Using the Find feature

■ Clicking to select items in a list

■ Marking (addresses only)

Choose Address List, Memo List, or To Do List from the View menu. After you 
view your data as a list, you can select the items you want to print.

Filtering
You can use filters to show only a portion of your addresses, memos, or To Do List 
items. For example, you could create a filter to show only the addresses with the 
category “Employees.” After you do that, the list view shows only the addresses in 
that category.

To print these records, choose the Addresses in List option from the Which 
Addresses pop-up menu in the Print dialog box.

For more information on creating list view filters, see Chapter 7.

Finding
You can use the Find command in much the same way as you use a filter. For 
example, you could find only the To Do List items with a priority of “medium.” 
After you do that, the list view shows only those items with priorities set to 
medium.
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Selecting records
To print these records, choose the To Dos in List option from the Which To Dos pop-
up menu in the Print dialog box.

For more information on using the Find feature, see Chapter 8.

Selecting records to print
You can select records by viewing a list, pressing and holding the a key, and 
clicking the records you want to print so they are highlighted in color. The records 
don’t have to be next to each other when you select them. This is a good temporary 
way to select individual records. These selections are not saved when the file is 
closed.

To print the selected records, choose the corresponding option in the selection pop-
up menu in the Print dialog box.

For more information on selecting items, see Chapter 7.

Marking addresses
If you are working with addresses, you can select records more permanently by 
marking them. To mark records, view the address list, then click the boxes next to 
the records you want to print. 

You can also mark an address from the address card.

Selected items

Marked address

Select to mark 
an address
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Chapter 11 Printing
To print the marked records, choose the option for Marked Addresses in the Which 
Addresses pop-up menu in the Print dialog box.

Marked addresses stay marked after the file is closed. For more information on 
marking addresses, see Chapter 3.

Previewing information
You can preview information before you print it. This is helpful so you can see the 
effect different printing options have before you print.

The Automatic Preview section in the Print dialog box shows a sample of the first 
printed page. This small view is based on the current settings in the Print dialog 
box. If you don’t want to see the preview sample, deselect the Automatic Preview 
check box.

Small preview 
of first printed 
page

Click for full-screen preview

Arrow shows direction of paper feed through printer
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Setting up printing for your day planner
If you want to see a larger preview, or you want to preview more than the first page 
of the printed information, click the Preview button, or click once in the preview 
sample when the pointer becomes a magnifying glass. A dialog box opens showing 
you a larger preview.

Setting up printing for your day planner
The first time you print you are prompted to choose the page format in which you 
want to print.

If you have purchased special blank paper for use with your day planner, you can 
print pages that are properly sized and formatted for that day planner paper.

If you’ve never used day planner paper in your printer before, it’s a good idea to 
print on plain paper first to make sure all settings are correct. For more 
information, check the instructions that came with the day planner paper, or your 
printer user guide.

If you decide not to choose a day planner now, you can make a selection later. You 
can also change your selection if you like. See “Changing or adding day planner 
information” in this chapter.

Click to see next 
preview page

Click to see 
previous 
preview page

Click to zoom in 
or out

Click to go to 
Page Setup

Click to go to back 
to the Print dialog 
box

Choose a 
day planner
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Chapter 11 Printing
Printing Date Book views
You can print the Day, Week, or Month view in Date Book for your day planner, or 
for a printing layout you create.

NOTE When you print Date Book views, any attachments connected to the items also 
print. Attachments only print with Date Book views.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Date Book button in the Print dialog box.

From the Print As pop-up menu choose the Date Book view you want to print. The 
Daily Date Book–Text option prints a simple list of your events, without any 
calendar graphics.

Change the From and To boxes so they show the range of dates that you want 
printed. If you want to print one day’s worth of information, type that date into 
both boxes. You can also use the calendar pop-up  instead of typing a date.

Choose a printing layout from the Layout pop-up menu. (The name varies, 
depending on which Date Book view you’re printing.)

Choose a layout 
from the Layout 
pop-up menu

Choose Day, 
Week, or Month 
view printouts

Choose the range 
of dates you want 
printed

Click to print

Choose a print layout
Choose Quick Print for a letter-sized 
calendar
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Printing To Do List items
Changing printing layouts for Date Book views
If the available printing layouts aren’t what you need, you can create a new layout. 
Make sure the Print As pop-up menu shows the type of Date Book view layout you 
want to create: Day, Week, or Month. Then choose Add New Layout from the 
Layout pop-up menu. The Printing Layout dialog box appears.

After you create and name a layout, it appears in the Layout pop-up menu.

To change or delete a layout, choose it from the Layout pop-up menu, then choose 
Edit Layout from the pop-up menu. Make the changes you want, then click Save, 
or click the Delete button if you want to delete the layout.

Printing To Do List items
You can print To Do List items together with Date Book information. However, you 
can also print them separately for a convenient “to-do” list.

You can choose which To Do List items you want to print—the entire set, or a 
smaller group. For more information, see “Selecting records” in this chapter.

Type a name for 
the new layout

Select paper size, 
orientation, and 
type of output

Select punch 
holes

Select font, font 
size, and font 
style

Choose which items to print

If printing double-sided monthly 
Date Book, click to spread each 
month across two pages

Click for more printing options

Click to edit this layout

New layout
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Chapter 11 Printing
Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the To Dos button in the Print dialog box.

From the Which To Dos pop-up menu, choose which items you want to print. 
Choose a layout from the List Layout pop-up menu. For letter-sized pages, choose 
Quick Print.

Changing printing layouts for To Do List items
If the available printing layouts aren’t what you need, you can create a new layout. 
From the List Layout pop-up menu, choose Add New Layout. The Printing Layout 
dialog box appears.

Choose to print 
all the items 
shown in the list, 
or just those 
you’ve selected

Click to print

Choose the 
layout you 
want

Select spacing 
options

Print the same columns in the same order as in 
the To Do List, or specify a new arrangement

Click for more printing options

Type a name for 
the new layout

Select paper size, 
orientation, and 
type of output

Select punch 
holes

Select font, 
font size, and 
font style
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Printing lists of Address Book items
After you create and name a layout, it appears in the List Layout pop-up menu.

To change or delete a layout, choose it from the List Layout pop-up menu, then 
choose Edit Layout from the pop-up menu. Make the changes you want, then click 
Save, or click the Delete button if you want to delete the layout.

Printing lists of Address Book items
You can print Address Book items in a simple list for quick reference, or you can 
print address cards, one per page.

You can choose which addresses you want to print—the entire set, or a smaller 
group. For more information, see “Selecting records” in this chapter.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Addresses button in the Print dialog box.

From the Print As pop-up menu, choose either Address List or Address Cards. 
Choose the addresses you want to print from the Which Addresses pop-up menu.

Click to edit this layout

New layout

Choose which 
addresses to print

Choose the layout 
you want

Choose the print 
format

Click to print

Choose to print all addresses, the addresses 
currently shown in list view, the addresses you’ve 
selected, or those you’ve marked in the address 
list
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Chapter 11 Printing
After you have decided which addresses you want to print, choose a layout from 
the List Layout pop-up menu. 

Printing an address card
If you want to print a single address card, first view the card by double-clicking it 
from the address list. Then choose Print from the File menu, or click the Print 
button on the toolbar. When you print while viewing a card, the Print As pop-up 
menu is set to print address cards.

While viewing an address card, you can choose to print the information in other 
ways, such as on an envelope, fax cover sheet, or label.

Changing printing layouts for lists of addresses
If the available printing layouts aren’t what you need, you can create a new layout. 
From the List Layout pop-up menu, choose Add New Layout. The Printing Layout 
dialog box appears.

Choose a print layout
Choose Quick Print for letter-sized pages

Click for more printing options

Select spacing options

Type a name for the 
new layout

Select paper size, 
orientation, and type 
of output
Select punch 
holes

Select font, 
font size, and 
font style
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Printing address books
After you create and name a layout, it appears in the List Layout pop-up menu.

To change or delete a layout, choose it from the List Layout pop-up menu, then 
choose Edit Layout from the pop-up menu. Make the changes you want, then click 
Save, or click the Delete button if you want to delete the layout.

Printing address books
You can print a regular address book with pages formatted to fit in a day planner 
binder. You can also create a mini-address book, which prints with cut and fold 
lines on letter-sized paper. An ultra mini-address book is similar, except it is even 
smaller. By editing address book layouts, you can choose which information 
appears in your address book: names, addresses, telephone numbers, and so on.

You can choose which addresses you want to print—the entire set, or a smaller 
group. For more information, see “Selecting records” in this chapter.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Addresses button in the Print dialog box.

From the Print As pop-up menu, choose either Address Book or Mini-Address 
Book.

Click to edit this layout

New layout

Choose which 
addresses to 
print

Choose the 
layout you 
want

Choose Address 
Book or Mini-
Address Book

Click to print
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Chapter 11 Printing
Choose the addresses you want to print from the Which Addresses pop-up menu.

After you have decided which addresses you want to print, choose a layout from 
the Layout pop-up menu. 

If you have chosen to print a Mini-Address book, you see different options in the 
Layout pop-up menu.

Finishing mini-address books
Mini-address books are set up to print on standard letter-sized paper. They are also 
set to print double-sided, so your addresses print on both sides of the paper. This 
is accomplished by printing on one side of the paper first, then re-feeding the paper 
so the printer can print on the other side.

See Appendix A for information on printing double-sided pages with your printer.

When your Mini-Address book is printed, cut the sheets on the dotted lines, and 
fold them on the solid lines. Assemble the pages to form a small booklet, then 
staple the center of the booklet if you like.

Choose to print all addresses, the 
addresses currently shown in list view, the 
addresses you’ve selected, or those you’ve 
marked in the address list

Choose a print layout
Choose Quick Print for letter-sized 
pages

Choose Mini-Book to print a book 
approximately 2.75” x 4.25”
Choose Ultra Mini-Book to print a book 
approximately 2” x 2.25”
124



Printing address books
Changing printing layouts for address books
If the available address book layouts aren’t what you need, you can create a new 
layout. From the Layout pop-up menu, choose Add New Layout. The Printing 
Layout dialog box appears.

If you are working with a Mini-Address book, the Printing Layout dialog box 
appears with different settings for size and output:

After you create a layout, it appears in the Layout pop-up menu.

Print the same 
columns in the same 
order as in 
the address list, or 
specify a new 
arrangement

Print by name, 
company or both

Click for more printing options

Choose name order

Click for each letter to 
start on a new page

Click for more printing options

Print by name, 
company or both

Print the same 
columns in the same 
order as in the 
address list, 
or specify a new 
arrangement

Choose name order

Click for each letter to 
start on a new page

Click to edit this layout

New layout
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Chapter 11 Printing
To change or delete a layout, choose it from the Layout pop-up menu, then choose 
Edit Layout from the pop-up menu. Make the changes you want, then click Save, 
or click the Delete button if you want to delete the layout.

Printing envelopes
You can print envelopes directly. You can even add a graphic to your return 
address.

You can choose which addresses you want to print envelopes for—one address, the 
entire list, or a smaller group. For more information, see “Selecting records” in this 
chapter.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Addresses button in the Print dialog box.

From the Print As pop-up menu, choose Envelopes.

Choose the addresses you want to print envelopes for from the Which Addresses 
pop-up menu.

To print an envelope for one address, display the address card or select the address 
in the address list. Choose the selected address in the Which Addresses pop-up 
menu.

Choose 
Envelopes

Choose Address 
Book items to print

Choose the type of 
envelope, address 
layout, and return 
address to print

Choose which 
address to print

Click to print

Choose to print all addresses, the 
addresses currently shown in list view, 
the addresses you’ve selected, or those 
you’ve marked in the Address list

Selected address
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Printing envelopes
If the person has more than one address, decide which one you want to use for 
your envelopes. “Primary” is the default name for the address on the left side of 
the address card, and “Secondary” is the default name for the address on the right. 
If you have chosen other address names in Address Book preferences, choose that 
name from the Which Address pop-up.

After you have decided which Address Book items and addresses you want to 
print, choose an envelope from the Envelope Form pop-up menu.

Choose how you want the addresses to appear by choosing from the Address 
Layout pop-up menu. By default, Formal/Business uses the person’s full name 
and includes a company name in the address. Informal/Personal uses only the 
person’s first and last name, and excludes a company name in the address. You can 
change address layouts—see “Changing printing layouts for envelopes” in this 
chapter.

Choose how you want your return address to appear by choosing from the Return 
Address pop-up menu.

If you have not used a return address before, choose Your Address from the Return 
Address pop-up. Then choose Edit Return Address. To add a new return address, 
choose Add New Return Address from the Return Address pop-up menu. See 
“Return address layouts” in this chapter for information on creating and changing 
return addresses.

If you are unsure how to print envelopes, consult the user guide that came with 
your printer for information on envelope feeding and direction of printing.

Prints the person’s primary address on the envelope

Prints the person’s secondary address on the envelope

Prints two sets of envelopes, one with each address

Choose a specific address name

Decide which address to use when the envelope prints

Choose an envelope form

Choose an address layout

Choose for your address
Choose to print no return address on the envelope
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Changing printing layouts for envelopes
If the Envelope Form or Address Layout arrangements aren’t what you need, you 
can create a new layout. From the Envelope Form pop-up menu, choose Add New 
Layout. The Envelope Layout dialog box appears.

Address layouts
You can also create an address layout by choosing Add New Layout from the 
Address Layout pop-up menu. The Address Layout dialog box appears.

After you create a layout of either type, it appears in its respective pop-up menu.

Type a name for the new layout

Click for more printing options

Enter the width and height of the envelope

Choose font and 
size for addressee

Choose the 
envelope 
orientation

Choose font and size for return address

Select to boldface 
recipient’s name 
only

Type a name for the new 
address layout
Choose a name format

Choose additional information to be printed on the envelope

New 
envelope 
layout

Click to edit 
this layout

New 
address 
layout

Click to edit 
this layout

Envelope Form Address Form
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Printing mailing labels
Return address layouts
You can create a new return address format. Choose Add New Return Address 
from the Return Address pop-up menu.

The new return address appears in the Return Address pop-up menu.

To change or delete a layout or a return address, choose the layout or return 
address from its pop-up menu, then choose Edit Layout or Edit Return Address 
from the pop-up menu. Make the changes you want, then click Save. Click the 
Delete button if you want to delete a layout or return address.

Printing mailing labels
You can print mailing labels for one address or a group of addresses. To print a 
label for one address, see “Printing an address card” in this chapter.

You can choose which addresses you want to print mailing labels for—the entire 
set, or a smaller group. For more information, see “Selecting records” in this 
chapter.

Type a name for the 
new return address

Type the text of the 
return address

If you want a picture with 
the return address, copy 
the picture to the 
Clipboard, then click Paste

Choose where picture 
should be relative to 
the return address

New layout

Click to edit this layout
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Chapter 11 Printing
Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Addresses button in the Print dialog box.

From the Print As pop-up menu, choose Mailing labels.

Choose the addresses you want to print mailing labels for from the Which 
Addresses pop-up menu.

Decide what address you want to use for your mailing labels. “Primary” is the 
default name for the address on the left side of the address card, and “Secondary” 
is the default name for the address on the right. If you have chosen other address 
names in Address preferences, choose that name from the Which Address pop-up 
menu.

Choose Mailing 
Labels

Choose which 
items to print

Choose the 
type of label

Choose the 
address to print

Choose the 
address layout to 
print

If the sheet has some labels missing, 
type the label to start with

Click to print

Choose to print all addresses, the addresses currently 
shown in list view, the addresses you’ve selected, or 
those you’ve marked in the address list

Prints the person’s primary address on the label

Prints the person’s secondary address on the label

Prints two sets of labels, one with each address

Choose a specific address

Decide which address to use when the label prints
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Printing mailing labels
After you have decided which Address Book items and addresses you want to 
print, choose a label size from the Label Form pop-up menu.

Choose how you want the addresses to appear by choosing from the Address 
Layout pop-up menu. By default, Formal/Business uses the person’s full name 
and includes a company name in the address. Informal/Personal uses only the 
person’s first and last name, and excludes a company name in the address. You can 
change address layouts—see “Changing printing layouts for mailing labels” in this 
chapter.

If you are working with a label sheet that has some labels missing, you can type a 
number into the Start printing on label box to indicate on which label on the sheet 
printing should begin. To determine the correct number, count the labels across 
first, then down.

If you are unsure how to print labels, consult the user guide that came with your 
printer.

To prevent wasting labels, you can check size, spacing, and formatting by printing 
on a plain piece of paper first before feeding any label sheets through the printer.

Changing printing layouts for mailing labels
If the Label Form or Address Layout arrangements aren’t what you need, you can 
create a new layout. From the Label Form pop-up menu, choose Add New Layout. 
The Mailing Label Layout dialog box appears.

Choose a label size

Choose an address layout
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Chapter 11 Printing
Address layouts
You can also create an address layout by choosing Add New Layout from the 
Address Layout pop-up menu. The Address Layout dialog box appears.

After you create a new layout of either type, it appears in its respective 
pop-up menu.

Type a name for the new layout

Click for more printing options

Type the number of 
rows and columns 
the label sheet has

Type distance from 
label sheet to edge 
of top label, and 
label sheet to edge 
of bottom label

Type margins inside 
the label, if you 
want

Enter font, size, and 
style information

Type width and height 
of a single label

Type distance from label sheet 
to edge of left label, and label 
sheet to edge of right label

Type a name for the 
new address layout

Choose a name format

Choose additional information to 
be printed on the label

New 
label 
layout

Click to edit 
this layout

New 
address 
layout

Click to edit 
this layout
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Printing return address labels
To change or delete a label or address layout, choose the layout from its pop-up 
menu, then choose Edit Layout from the pop-up menu. Make the changes you 
want, then click Save, or click the Delete button if you want to delete the layout.

Printing return address labels
You can print return address labels. You can even add a graphic to the return 
address.

One sheet of return address labels is printed. If you want more than one sheet, type 
the number of copies you want in your printer’s Print dialog box just before you 
print. For fewer labels, change the number in the “Start printing on label” field 
until the Preview shows the number of labels you want.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Addresses button in the Print dialog box.

From the Print As pop-up menu, choose Return Address Labels.

Choose which return address you want to use for your labels from the Return 
Address pop-up menu.

If you have not used a return address before, choose Your Address from the Return 
Address pop-up. Then choose Edit Return Address. To add a new return address, 
choose Add New Return Address from the Return Address pop-up menu. See 
“Return address layouts” in this chapter for information on creating and changing 
return addresses.

Choose the 
layout you want

Choose which 
return address 
to print

Choose Return 
Address Labels

Type a number to adjust the number of return 
address labels if you want fewer than a full sheet

Click to print

Choose for your address

Edit an existing return address layout
Add a new return address layout
133



Chapter 11 Printing
Choose a label from the Label Layout pop-up menu.

If you are working with a label sheet that has some labels missing, you can type a 
number into the “Start printing on label” box to indicate on which label on the 
sheet printing should begin. To determine the correct number, count the labels 
across first, then down.

If you are unsure how to print labels, consult the user guide that came with your 
printer.

To prevent wasting labels, you can check size, spacing, and formatting by printing 
on a plain piece of paper first, before feeding any label sheets through the printer.

Printing fax cover sheets
To view the address card you want to print a fax cover sheet for, double-click it in 
the Address list. You can also show what addresses you want a fax cover sheet for 
by clicking the address once in the address list to select it.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Addresses button in the Print dialog box.

From the Print As pop-up menu, choose Fax Cover Sheet.

Choose a label size

Type how many 
pages the final 
fax is to have

Choose the 
layout you want

Choose Fax 
Cover Sheet

Click to print the fax 
to the Clipboard as 
a PICT graphic

Click to type the body text of the fax Click to print
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Printing fax cover sheets
Type the total number of pages the fax is to have, so this information is printed on 
the cover sheet.

Choose how you want the fax address to appear by choosing from the Fax Layout 
pop-up menu. By default, Formal/Business uses the person’s full name and 
company name on the fax cover sheet. Informal/Personal uses only the person’s 
first and last name. You can change fax layouts—see “Changing printing layouts 
for fax cover sheets” in this chapter.

Click the Edit Body button, then type the body text of the fax. Click OK or press 
Enter when you’re done.

If you want the fax to be sent to the Clipboard as a PICT graphic file, instead of to 
your printer, select Print to Clipboard as PICT. You can then paste the fax image 
from the Clipboard into another software application.

For example, if you have a document created in another software application that 
you want to fax from your computer, you can create the fax cover sheet, copy the 
fax cover sheet to the Clipboard, then paste it into the other document.

Changing printing layouts for fax cover sheets
If the fax layout arrangement isn’t what you need, you can create a new one. From 
the Fax Layout pop-up menu, choose Add New Layout. The Fax Layout dialog box 
appears.

Choose a fax layout form

Type text for the fax
135



Chapter 11 Printing
After you create a layout, it appears in the Fax Layout pop-up menu.

To change or delete a layout, choose it from the Fax Layout pop-up menu, then 
choose Edit Layout from the pop-up menu. Make the changes you want, then click 
Save, or click the Delete button if you want to delete the layout.

Printing memos
You can choose which memos you want to print—the entire set, or a smaller group. 
For more information, see “Selecting records” in this chapter. You can also print a 
single memo while you are viewing or editing it.

Choose Print from the File menu, or click the Print button on the toolbar. Then click 
the Memos button in the Print dialog box.

Type a name for the new fax layout

Click for more printing options

Enter your name 
and other 
information

Choose font, 
size, and style 
information

Choose how you want 
recipient’s information to appear

New layout

Click to edit this layout
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Printing memos
Choose which memos you want to print from the Which Memos pop-up menu. 

Choose a layout from the Memo Layout menu. 

Changing printing layouts for memos
If the available printing layouts aren’t what you need, you can create a new layout. 
From the Memo Layout pop-up menu, choose Add New Layout. The Printing 
Layout dialog box appears.

Choose which 
memos to 
print

Choose the 
layout you want

Click to print

Choose to print either all memos, only those shown 
in the memo list view, or just those you’ve selected

Choose a print layout
Choose Quick Print for letter-sized pages
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Chapter 11 Printing
After you create a layout, it appears in the Memo Layout pop-up menu.

To change or delete a layout, choose the layout from the Memo Layout pop-up 
menu, then choose Edit Layout from the pop-up menu. Make the changes you 
want, then click Save, or click the Delete button if you want to delete the layout.

Changing or adding day planner information
The first time you print, you are prompted for information about your day planner. 
If you want to change that information, or if you did not initially specify a day 
planner, you can update this information.

In the Print dialog box, choose Paper Planner Interview from the Layout menu in 
the bottom left corner. The Paper Planner Interview menu choice is available when 
printing Date Book views, address lists, address books, mini-address books, 
memos, or To Do Lists.

Click if you want 
to print each 
memo on a 
separate page

Print the same 
columns in the 
same order as in 
the To Do List 
view, or specify a 
new 
arrangement

Type a name for the new layout

Click for more printing options

New layout

Click to edit this layout
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Setting custom margins
The Paper Planner Interview dialog box appears. Choose a day planner and a 
binder size.

If you have previously selected a paper planner, you are prompted to indicate if 
you want this new information to replace the old, or be added to it. Click Replace 
if you are changing day planners, or Add if you want to have a choice of day 
planner formats.

If you want information formatted to print on standard letter-sized sheets, rather 
than day planner sheets, choose Quick Print from the Layout menu.

Setting custom margins
You can fine-tune the print settings if you need to.

In the Print dialog box, choose Margins Setup from the Layout menu in the bottom 
left of the Print dialog box. The Margins Setup menu option is available when 
printing Date Book views, address lists, address books, mini-address books, 
memos, or To Do Lists.

Choose a day planner

Choose a binder size
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Chapter 11 Printing
The Margins Setup dialog box appears. If your printouts are being “cut off” by 
your printer, you may need to decrease the page margin settings slightly. The 
default settings, as well as the “Minimums” settings, are determined by your 
printing software.

If you are printing double-sided pages, such as you would for a mini-address book, 
and the cut lines do not line up from one side of the page to another, measure the 
difference between the cut lines on the two sides, then type one-half that distance 
in the Double-sided offset box.

Adjustment for page margins

Adjustment for two-sided printing

Click to set for the minimum 
margins allowed by your printer
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CHAPTER 12

HotSync® Operations

When you use both a computer and a handheld to access information, you want 
the information to be the same—and the most up-to-date—wherever you access it. 
The HotSync® operation is designed to quickly and conveniently synchronize 
information between your computer and your handheld.

See online Help for detailed information about HotSync operations. Help is 
available from the main menu and from the Help button in dialog boxes.

About HotSync operations
A HotSync operation is a two-way exchange and update data between your 
handheld and your computer. This two-way exchange “synchronizes” your data, 
which means that after a HotSync operation, your data is the same on your 
handheld and on your computer. Changes that you make on one side are made on 
the other. HotSync Manager transfers new and changed portions of data, thereby 
reducing time needed to complete the HotSync operation. 

With HotSync technology, you can do the following:

■ Synchronize the data from applications on your handheld with the 
corresponding modules on your computer, and vice versa.

■ Install applications and add files from your computer to your handheld, or if 
your handheld has an expansion card slot, to an expansion card inserted in your 
handheld.

■ Manage one or more handhelds with a single computer.

■ Keep your data safe by automatically creating backup copies of all your data 
each time you synchronize.

NOTE You can also use the Merge feature to merge the data of two data files so that 
each data file contains all the data from the other. A dialog box shows the progress 
of the merge. If conflicts occur, Palm™ Desktop software prompts you for assistance. 
See online Help for detailed information about the Merge feature.

During a HotSync operation, your computer receives a ”synchronize” command 
from your handheld. An application in the background, called the Transport 
Monitor, is always working (after you enable it) to detect a HotSync connection 
from your handheld. When the Transport Monitor recognizes the connection, it 
calls the Conduit Manager to oversee the HotSync operation.
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Chapter 12 HotSync® Operations
If an application synchronizes data between your computer and your handheld, 
the application uses a conduit to transfer the data. The Conduit Manager, another 
background application on your computer, manages each conduit. 

You work only with HotSync Manager. The background applications are called 
automatically when they are needed.

You can connect your handheld with your computer to perform a HotSync 
operation in various ways:

■ Cradle/cable HotSync operation

The most commonly used method, also called a local HotSync operation. The 
cradle/cable connects to a USB or serial port on your computer. For the first 
HotSync operation, you must perform a local HotSync operation.

■ IR HotSync operation

If your handheld uses Palm OS® software 3.3, 3.5, or later, its infrared (IR) port 
supports the IrCOMM implementation of the IrDA standards for infrared 
communication. This means that you can use the IR port to perform HotSync 
operations, and you don’t need your HotSync cradle/cable. This is especially 
useful if you travel with an infrared-enabled laptop.

NOTE At the time of this writing, the current release of Mac OS X does not 
enable you to perform IR HotSync operations. Check the documentation for 
your release of Mac OS X to find out if this situation has changed.

■ Modem HotSync operation

Uses two modems: one connected to your handheld, the other to your 
computer. Use a modem HotSync operation to synchronize data when you 
want to dial directly into your computer from a remote location.

Accessing HotSync Manager
HotSync Manager works closely with Palm Desktop software, but it is a separate 
application. You can access HotSync Manager in the following ways:

■ In Palm Desktop software, from the HotSync menu, choose the command you 
want.

■ In the Palm folder, double-click the HotSync Manager icon. This opens the 
HotSync Software Setup dialog box.

■ From the menu in Instant Palm Desktop application, choose HotSync.
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Preparing for the first HotSync operation
Preparing for the first HotSync operation
Before you can perform your first HotSync operation, you must connect the 
HotSync cradle/cable to your computer. How you make this connection depends 
on the following:

■ The kind of HotSync cradle/cable you have.

Your cradle/cable has either a USB connector or (if the cradle/cable is an older 
model) a connector that requires an adapter to make it work with either a USB 
port or a serial port. If you’re not sure what kind of cradle/cable you have, 
consult the documentation that came with your handheld.

■ The kind of port on your computer that you want to connect to: a USB port or a 
serial port.

There are three kinds of connections you can make:

If you need to make connection B or C and lack the necessary hardware, visit the 
store at the Palm web site to learn about peripherals that enable you to make the 
connection. From the Help menu in Palm Desktop software, choose Visit Palm on 
the Web.

NOTE Your first HotSync operation must be a local operation using the cradle/cable 
connection.

Connecting a USB cradle/cable to a USB port
Plug the USB connector of your cradle/cable into a USB port on your computer. 
Next, open the Palm folder on your computer and start HotSync Manager. Click 
the Connection Settings tab of the HotSync Software Setup dialog box and select 
the On check box next to USB. Click the HotSync Controls tab and enable the 
Transport Monitor, if it is not already enabled. Close the HotSync Software Setup 
dialog box.

Connecting a serial cradle/cable to a USB port
Connect the USB adapter to the end of the HotSync cradle/cable. Next, connect the 
adapter cable to a USB port on your computer. Open the Palm folder on your 
computer and start HotSync Manager. Click the Connection Settings tab of the 
HotSync Controls tab and select the On check box next to PalmConnect® USB. If 
you are using a USB adapter from a third-party vendor, look for the name of the 

A USB cradle/cable to your computer’s USB port

B Serial cradle/cable to your computer’s USB port

C Serial cradle/cable to your computer’s serial port
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adapter and select its On check box. Click the HotSync Controls tab and enable the 
Transport Monitor, if it is not already enabled. Close the HotSync Software Setup 
dialog box.

Connecting a serial cradle/cable to a serial port
Connect the Mac serial adapter to the end of the HotSync cradle/cable. Next, 
connect the adapter cable to either the printer or modem port on the back of your 
computer (remember which port you connected to). Open the Palm folder on your 
computer and start HotSync Manager. Click the Connection Settings tab of the 
HotSync Software Setup dialog box. Select the On check box next to Printer Port or 
Modem Port, depending on which port you connected to. Click Settings, select 
Serial in the Settings dialog box, select the speed, select the modem if you are using 
one, and click OK. Click the HotSync Controls tab and enable the Transport 
Monitor, if it is not already enabled. Close the HotSync Software Setup dialog box.

Sharing a port with the cradle/cable and another device 
In order to perform HotSync operations, you must have the Transport Monitor 
enabled on your computer. By default, the Transport Monitor is enabled whenever 
you start your computer. Keep this default behavior if your HotSync cradle/cable 
is always connected to a port that you use exclusively for HotSync operations.

If, however, you use the same port for other devices (such as an AppleTalk network 
connection or a printer cable) besides the cradle/cable, disable the Transport 
Monitor, and then enable it manually whenever you connect the cradle/cable to 
perform a HotSync operation.

To disable Transport Monitor, from the HotSync menu, select Setup. In the HotSync 
Controls tab, select Disabled. Under HotSync Options, deselect the check box for 
the option Enable HotSync software at system startup. Close the HotSync Software 
Setup dialog box.

To manually enable the Transport Monitor, open the Palm Folder on your 
computer and start HotSync Manager. In the HotSync Controls tab, select Enabled. 
Close the HotSync Software Setup dialog box.

Changing conduit actions
The HotSync Manager uses conduits to transfer data between the applications or 
databases on your handheld and its counterpart in Palm Desktop software on your 
computer. In general, you don’t need to change the default conduit settings. The 
main reason to change the default settings from a two-way to a one-way transfer 
would be to overwrite all of an application’s data on your handheld or computer.
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Changing conduit actions
You specify synchronization rules by selecting Conduit Settings from the HotSync 
menu. Select the conduit (Address Book, Date Book, Memo Pad, or To Do List) and 
then click the Conduit Settings button. 

The Conduit Settings dialog box gives you choices for synchronizing each conduit. 
Select the application, then select one of the following HotSync actions:

■ Synchronize the files on the handheld and desktop (two way)

■ Desktop overwrite the handheld (one way)

■ Handheld overwrite the desktop (one way)

■ Do nothing
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Chapter 12 HotSync® Operations
Performing a local cradle/cable HotSync operation
Keep the following points in mind when performing a local HotSync operation:

■ The first time you perform a HotSync operation with a new handheld or after a 
hard reset, you need to assign a username to the handheld. HotSync Manager 
prompts you to enter a name or select an existing name. Select an existing name 
only if it corresponds to the handheld. Do not use the same username for more 
than one handheld.

■ To stop a HotSync operation that is in progress, click the Cancel button in the 
HotSync Progress dialog box on your computer or handheld. If the HotSync 
Progress dialog box is not displayed, Tap Cancel on your handheld. 
Cancellation is not immediate; give the HotSync operation time to stop.

■ After completing the first HotSync operation with the local cradle/cable 
connection, you can set up and perform HotSync operations using other 
connection methods (for example, IR or modem).

To perform a local HotSync operation, connect your handheld to the cradle/cable. 
Enable the Transport Monitor, if it is not already enabled, and select the connection 
method if it is not already selected. Press the HotSync button on the cradle/cable. 
If your cable does not have a HotSync button, turn on your handheld, open the 
HotSync application, and tap the HotSync icon. If this is the first HotSync 
operation and you assigned a password to your handheld, HotSync Manager 
prompts you to enter the password on your computer. Enter the password and 
click OK. Wait for a message on your handheld indicating that the operation is 
complete, and then remove your handheld from the cradle/cable.

About the data file
Palm Desktop software stores your events, addresses, memos, and To Do List items 
in one data file on your computer. You must maintain a separate data file for each 
person who uses Palm Desktop software on the same computer. As described in 
Chapter 1, you can open only one data file at a time in Palm Desktop software.

Your data file, called User Data, is created the first time you install Palm Desktop 
software. The User Data file is located in a folder that has the same name as the 
username of your handheld, which in turn is located in the Users folder.

For example, if you entered “Jane Garcia” as your username, your data file (User 
Data) is in the folder called Jane Garcia. The folder called Jane Garcia is in the Users 
folder.

The location of the Users folder depends on the operating system used by the 
computer and the number of people who are defined as Mac users.
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Synchronizing multiple data files
Depending on the status of the handheld, during the first HotSync operation of a 
handheld and a computer, HotSync Manager behaves as follows:

■ If you have already synchronized the handheld with another computer, the 
handheld has a username. HotSync Manager automatically creates a new data 
file in Palm Desktop software, using the same username as the one on the 
handheld, and then synchronizes the data.

■ If the handheld has no username (that is, it has never been synchronized with 
any computer, it has been hard reset, or it has been synchronized only with a 
user profile), HotSync Manager displays the New Users dialog box so that you 
can create a username for a new data file, and then synchronizes the data.

The first time you perform a HotSync operation, the Palm Desktop software data 
file you indicate and your handheld are linked. When you synchronize data in the 
future, the HotSync Manager always synchronizes with the same data file. Make 
sure that you are using the correct file when you open Palm Desktop software. To 
find out if you are using the correct file, check to see if your username appears as 
the User displayed on the right side of the toolbar. If your username does not 
appear, click the User pop-up menu and choose your name from the list.

NOTE By creating a user profile, you can preconfigure Palm OS handhelds with the 
same set of data (addresses, events, memos, and To Do List items) and applications 
before each handheld is individualized with a specific username and data file. See the 
online Help for more information about user profiles.

Synchronizing multiple data files
You can synchronize data between your handheld and two or more different types 
of computers, even between a Mac computer and an IBM-compatible running 
Windows operating system—so long as the computers have HotSync Manager 
installed on them. The data files on the two computers will have the same 
username. For example, you can synchronize data between two computers, 
between one PC and one Mac computer, between a portable and a desktop, and so 
on.

For some users, it is useful to have Palm Desktop software and their personal 
information on more than one computer (for example, on an office computer and 

Mac OS User Location of data file

Mac OS X Any kind of Mac user. <Hard Disk>/Users/[Mac username]/
Documents/Palm/Users/[your username]

Mac OS 9 You are the only user (you 
are defined as the 
computer Owner).

<Hard Disk>/Documents/Palm/Users/[your 
username]

Mac OS 9 You are one of multiple 
users and you are not the 
computer Owner.

<Hard Disk>/Users/[Mac username]/
Documents/Palm/Users/[your username]
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Chapter 12 HotSync® Operations
a home computer). Having two data files creates the problem of making sure both 
contain the same information. The easiest way to ensure multiple data files contain 
the same information is to perform HotSync operations with both computers on a 
regular basis.

To synchronize with another computer, perform a HotSync operation with your 
handheld and the computer that you normally synchronize with. Then perform a 
HotSync operation with your handheld and your secondary computer. HotSync 
Manager automatically creates a user on Palm Desktop software using the unique 
username assigned to your handheld. The HotSync operation copies all data from 
the handheld to the secondary computer.

Synchronizing multiple handhelds to one computer set up for multiple 
Mac users

A Mac computer can be set up to host multiple users. To do this, the computer’s 
owner creates an account for each person who is to use the computer. Each account 
defines a user’s environment on the computer: the account regulates the user’s 
access to the computer’s locations, applications, and capabilities (for example, 
access to HotSync Manager and the capability to print from the computer).

Note that this situation differs from having many users using the same computer, 
all of whom have undefined and unlimited access to the computer. Consult the 
documentation of your computer for more information about multiple Mac users.

This information is important to you as a user of Palm Desktop software because 
on computers with multiple Mac users, a user of Palm Desktop software must be 
hosted by one of the Mac users and must be given access to Palm Desktop software 
and HotSync Manager. Then, to see your data, you must first log into the correct 
Mac user environment using a Mac username and password; these are given to 
you by the person who is defined as the Owner of the computer. You can then 
access Palm Desktop software and your data.

Log in as the correct user
Before you synchronize or otherwise work with your data, be sure the computer is 
logged in under the Mac user who hosts you. If you work on the computer under 
the wrong Mac username and open Palm Desktop software, you are likely to 
encounter the following problems:

■ Your username is not in the User pop-up menu because you do not have 
privileges in this environment. Your data is also unavailable for the same 
reason: you are in the wrong environment.

■ If you synchronize in this environment, HotSync Manager cannot find your 
original data file and thus proceeds as if this were the first HotSync operation 
with your handheld on this computer. It automatically creates a new data file 
using the username on your handheld and loads your data into this wrong 
environment.
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Installing applications on your handheld or an expansion card
Installing applications on your handheld or an expansion card
Use HotSync Manager to install applications and files from your computer to your 
handheld or to an expansion card inserted in your handheld. Visit the Palm web 
site, www.palm.com, to find links to other web sites from which you can download 
handheld applications to your computer.

NOTE By default, Palm™ applications (files with the extension PRC, PQA, PDB, or 
SCR) are installed to your handheld, but you can change their destination to an 
expansion card if your handheld is equipped with an expansion card slot. All other 
files must be installed on an expansion card.

To install applications and files to your handheld or expansion card:

1. Add the application or files to your install list.

2. From the User pop-up menu on the toolbar, choose the username of the 
handheld to which you want to install applications. 

3. In Palm Desktop software, from the HotSync menu, select Install Handheld 
Files. 

If the file you want to install is not listed in the dialog box, go to the folder to 
which you copied the file.

4. Select the application(s) or file(s) you want to install on your handheld and click 
Add file. 

5. Close the Install Handheld Files dialog box. 

To install an application to a destination other than the one shown in the 
Destination column, click Change Destination and make the changes. The 
Change Destination button is only available if your handheld is equipped with 
an expansion card slot and this is not the first HotSync operation.

6. Press the HotSync button on the cradle/cable to perform a HotSync operation. 
This installs the application(s) and file(s) to the destination you selected.

Files that remain in the list after you perform a HotSync operation did not install 
on the handheld. If this happens, here are some likely reasons:

■ Your handheld ran out of memory.

■ The file type was not recognized during the HotSync operation. Expansion 
cards may hold applications that use files other than the Palm application files. 
In order for your handheld to recognize such a file, you must launch the 
application that uses these files at least once.
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Chapter 12 HotSync® Operations
Archiving data you delete from your handheld
When you delete an item from your handheld, you have the option to have the 
item archived on your computer during the next HotSync operation. The archive 
only contains items you delete from the handheld; items deleted from the 
handheld through synchronization with Palm Desktop software are not archived.

NOTE Records that are deleted or purged from the handheld are archived only if the 
option Save archive copy on PC is selected for that record on the handheld during the 
purge or deletion.

The archive file is called “User Data Archive” and is located in the Users folder in 
the folder with the name corresponding to the name of your handheld. For 
example, if you entered “Jane Garcia” as your username, the archive file is located 
in the folder called “Jane Garcia” in the User folder.

Resolving HotSync conflicts
After performing a HotSync operation, you may receive a message that indicates 
errors occurred. If you have errors, select View Log from the HotSync menu to 
display a description of these errors. After you correct the errors, perform another 
HotSync operation to ensure you corrected all errors. For more information, see 
troubleshooting in the HotSync Manager online Help.
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CHAPTER 13

Using the Instant Palm™  Desktop Application

This chapter explains the basics of using the Instant Palm™ Desktop application.

About the Instant Palm Desktop application
The Instant Palm Desktop application provides you with quick access to many of 
the most frequently used features of Palm™ Desktop software and HotSync® 
Manager.

You can display or hide the Instant Palm Desktop menu by choosing Preferences 
from the Palm Desktop menu in Mac OS X or from the Edit menu in Mac OS 9. 
Click General, and then select the Show Instant Palm Desktop menu checkbox. In 
Mac OS 9, you must restart your computer for this change to take effect.

When the Show Instant Palm Desktop checkbox is selected in Preferences, you can 
display the Instant Palm Desktop menu. In Mac OS X, click and hold the Palm 
Desktop icon in the dock when Palm Desktop is running or hidden. In Mac OS 9, 
click the Instant Palm Desktop menu icon in the upper-right corner of the screen.

NOTE In Mac OS X, the Instant Palm Desktop menu is only available when Palm 
Desktop is currently running or hidden. In Mac OS 9, the Instant Palm Desktop menu 
is also available when Palm Desktop is not running.

In Mac OS X, click 
and hold the 
Palm Desktop 
icon in the dock
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Chapter 13 Using the Instant Palm™ Desktop Application
From the Instant Palm Desktop menu, you can launch both Palm Desktop and 
HotSync Manager software and perform the following:

■ See your Date Book events and To Do List items for today

■ Show designated addresses and phone numbers, and dial phone numbers

■ Quickly start Palm Desktop software or switch to it from another application

■ Search for addresses 

■ Create addresses, events, memos, and To Do List items

Working with addresses
In the Instant Palm Desktop menu, you can search for and display addresses, and 
add their names and phone numbers to the Instant Palm Desktop menu. 

NOTE For more information about setting up for dialing telephone numbers, see 
“Setting dialing preferences” in Chapter 3.

In Mac OS 9, click the Instant Palm 
Desktop icon in the upper-right 
corner of the screen

To see all of the 
information for 
an address, 
select the 
name

The diamond 
indicates the 
upcoming event 
for the current 
day

To Do List 
items are 
listed in the 
order they 
were created
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Working with addresses
Choose Find Address from the Instant Palm Desktop menu to search for an 
address. The Find Address dialog box appears.

When you click Add to Menu, you see a dialog box similar to the one below.
.

When you click Display in the Find Address dialog box, you see a non-editable 
version of the address card.
.

Click to add the selected item to the 
Instant Palm Desktop menu

Enter the initials or the 
first few letters of the 
name you want to find

Click to show a non-
editable version of the 
address card

Click to show the name and 
phone number in the 
Instant Palm Desktop 
menu

Click to copy 
the selected 
field(s) to the 
Clipboard

Click to dial 
the phone 
number

Click to copy all of 
the fields to the 
Clipboard
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Chapter 13 Using the Instant Palm™ Desktop Application
To remove an address from the Instant Palm Desktop menu, display the 
appropriate address card and deselect the box next to the phone number. You can 
do this from either the Instant Palm Desktop address card or the address card in 
Palm Desktop software.

Creating items from the Instant Palm Desktop menu
You can create an event, To Do List item, address, or memo from the Instant Palm 
Desktop menu. 

Choose Create from the Instant Palm Desktop menu, and then choose the type of 
item you want to create from the submenu.

Click to remove the item 
from the Instant Palm 
Desktop menu

You can create an event, To 
Do List item, address, or 
memo from the Instant 
Palm Desktop menu
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APPENDIX A

Printing Double-Sided Pages

You can print on both sides of a page to produce compact printed output. You print 
one side first, then you are prompted to reinsert the printed pages to print the other 
side.

This appendix shows you how to print double-sided pages. Read the section for 
your particular printer. If there is no section for your printer, see the user’s guide 
that came with your printer or consult your printer’s manufacturer.

You can print your calendar and address book pages to fit several standard double-
sided page organizers:

■ 8.5 inch by 11 inch (Portfolio)

■ 5.5 inch by 8.5 inch (Organizer)

■ 4.25 inch by 6.75 inch (Compact)

■ 3.75 inch by 6.75 inch (Sr. Pocket)

■ 3.5 inch by 5 inch (Pocket)

■ 3 inch by 5 inch (Memo)

■ 2.75 inch by 5 inch (Jr. Pocket)

■ 2.75 inch by 4.25 inch (MiniBook 8)

■ 2 inch by 2.25 inch (MiniBook 12)

Marking paper for hole-punches
If you are not using pre-punched and pre-printed forms, you can print hollow 
circles where the holes should be punched and dashed lines where you should cut 
the paper. To mark the paper for hole-punching and cutting, choose Print from the 
File menu, and then choose Edit Layout from the Layout pop-up menu. The 
Printing Layout dialog box appears. For more information on editing layouts, see 
Chapter 11.
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Appendix A Printing Double-Sided Pages
Apple LaserWriter/LaserWriter Plus, Hewlett-Packard DeskWriter
For the LaserWriter, LaserWriter Plus, and DeskWriter, these are the general steps:

■ Print one side of the page

■ Reverse the order of the pages

■ Print the other side of the page

Follow the instructions in Chapter 11 for printing. Follow these steps after printing 
has begun:

1. If you’re using pre-punched paper, feed the paper in the printer so that the holes 
enter the printer first.

The printed pages come out of the printer in reverse order and printed side up. 
The first page printed (for example, January/April or the A’s if you’re printing 
addresses) is at the bottom of the stack.

While the first side is printing, you see a message on the screen.

2. Wait until all the pages have printed and then remove the printed pages.

Select these 
options to show 
you where to 
punch holes and 
cut away excess 
paper

Edge with the holes 
enters the printer first
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Apple Personal LaserWriter, Hewlett-Packard LaserJet IIP and IIIP
3. Reverse the order of the pages.

The first page that was printed should be on top of the stack of pages; the last 
page should be on the bottom of the stack.

4. Insert the pages back into the paper tray, printed side up.

Make sure to feed the same edge in the printer as you did in step 2.

5. Click Print Backs.

Apple Personal LaserWriter, Hewlett-Packard LaserJet IIP and IIIP
For the Personal LaserWriter SC/NT/LS and the LaserJet IIP/IIIP, these are the 
general steps:

■ Print one side of the page

■ Reverse the order of the pages

■ Print the other sides of the pages

NOTE If the printer has a face-up tray, these steps assume the tray is closed.

Follow the instructions in Chapter 11 for printing. Follow these steps after printing 
has begun:

1. If you’re using pre-punched paper, feed the paper in the printer so that the holes 
enter the printer first.

The printed pages come out of the printer with the first page at the bottom of 
the stack and the printed side down. The first page printed (for example, 
January/April or the A’s if you’re printing addresses) is at the bottom of the 
stack.

While the first side is printing, you see a message on the screen instructing you 
to remove the pages and reinsert them as appropriate.

Edge with the holes 
enters the printer 
first
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Appendix A Printing Double-Sided Pages
2. Wait until all the pages have printed and then remove the printed pages.

3. Reverse the order of the pages so that the first page printed is on the bottom.

4. Insert the pages back into the paper tray, printed side down.

5. Click Print Backs.

Apple LaserWriter II series, Hewlett-Packard LaserJet III and IIID
For the LaserWriter II SC/NT/NTX/F/G and the LaserJet III/IIID, these are the 
general steps:

■ Print one side of the page

■ Reverse the order of the pages

■ Print the other sides of the pages

NOTE These steps assume the printer’s face-up tray is closed.

Follow the instructions in Chapter 11 for printing. Follow these steps after printing 
has begun:

1. If you’re using pre-punched paper, feed the paper in the printer so that the holes 
enter the printer first.

The printed pages come out of the printer with the first page at the bottom of 
the stack and the printed side down. The first page printed (for example, 
January/April or the A’s if you’re printing addresses) is at the bottom of the 
stack.

Edge with the holes 
enters the printer 
first
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Apple LaserWriter Pro 630 and 16/600PS
While the first side is printing, you see a message on the screen instructing you 
to remove the pages and reinsert them as appropriate.

2. Wait until all the pages have printed and then remove the printed pages.

3. Reverse the order of the pages so that the first page printed is on the bottom.

4. Insert the pages back into the paper tray, printed side down.

5. Click Print Backs.

Apple LaserWriter Pro 630 and 16/600PS
For the Apple LaserWriter Pro 630, 16/600, and some similar printers, these are the 
general steps:

■ Print one side of the page

■ Flip over the stack of pages

■ Reverse the pages 180 degrees

■ Print the other sides of the pages

Follow the instructions in Chapter 11 for printing. Follow these steps after printing 
has begun:

1. If you’re using pre-punched paper, feed the paper in the printer so that the holes 
enter the printer first.

The printed pages come out of the printer with the first page at the bottom of 
the stack and the printed side down. The first page printed (for example, 

Edge with the holes 
enters the printer 
first
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Appendix A Printing Double-Sided Pages
January/April or the A’s if you’re printing addresses) is at the bottom of the 
stack.

While the first side is printing, you see a message on the screen instructing you 
to remove the pages and reinsert them as appropriate.

2. Wait until all the pages have printed and then remove the printed pages.

3. Flip over the stack so that the first page that was printed is at the top of the stack.

The first page that printed should be on top of the stack of pages; the last page 
should be on the bottom of the stack.

4. Turn the pages around 180 degrees.

5. Insert the pages back into the paper tray, printed side up.

6. Click Print Backs.
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application on your handheld 51
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changing 44
copying and pasting 50
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viewing 86
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exporting data to 110
importing data from 107

archiving handheld data 150
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attaching records 100
automatic 100

deleting 104
files 103
letters 53
memos 72
transferring to your handheld 99
viewing 104

auto-completion, in typing entries 47
auto-dialing 54, 153
automatic attachments 100

B
backgrounds. See decors
birthdays 46, 49
button bar 10

C
capitalization, automatic 47
categories 96–98
characters, text 13
cities 46
Claris Organizer 107
ClarisWorks 53, 104
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columns, in list views 90
completed To Do List items 81, 86
conduit
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settings 144

continuous events 62
custom fields 45, 47
custom filters 87

D
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exporting 110
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Date Book
adding To Do List items to 77
application on your handheld 66
described 4
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printing 118–119
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changing 64
formatting 12
moving to specific 93
selecting 114

day planners 117, 138
Day Runner day planners 117
Day view 4, 60
days, changing in Week view 60, 67
Day-Timer day planners 117
decors 14
default options 12
deleting

attachments 104
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events 66
from handheld 150
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To Do List items 82

DeskWriter 156
dialing 54

from Instant Palm Desktop menu 153
preferences 56

double-sided printing 155–160

E
e-mail

accessing 48
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entering information 8
entry lists 46
envelopes, printing 126
events 4

attaching 99
categorizing 96
changing 64
creating 61
deleting 66

finding 93
printing 119
repeating 62
selecting 114
transferring to your handheld 66

exporting data 110

F
faxes 46, 134
files

attaching 103
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creating 7
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searching in 94
synchronizing 141
transferring to your handheld 103

filtering information 86, 114
finding

addresses 94, 152
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memos 72
text 87, 94

fonts 13
Franklin day planners 117
frequently used items 95

G
getting started 6, 17
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H
hiding

To Do List items 61
toolbar 12

high priority To Do List 80
HotSync operation

conflicts 150
errors 150
HotSync log 150
local 142
overview 141
setting up 147
synchronizing user data files 147
using IR port 142
using modem 142
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I
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IR HotSync 142

L
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printing 129
printing return addresses 133

LaserJet III and IIID 158
LaserJet IIP and IIIP 157
LaserWriter 156
LaserWriter II 158
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addressing 50
attaching 53

list views 85
lists 85

hiding columns in 90
of addresses 43
of memos 70
of To Do List items 78
sorting 89
viewing partial 86

lists, to-do. See To Do List
Local HotSync 142
logos, in return addresses 129

M
MacWrite Pro 53
mailing labels

printing 129–133
marking

addresses, for printing 52, 115
completed To Do List items 81

Memo Pad
application on your handheld 73
described 5

memory, adjusting 15
memos 69–73

attaching 72, 99
categorizing 96
changing 71
deleting 72

finding 72, 94
selecting 114
showing all 88
transferring to your handheld 73
viewing 70, 86

menus
adding items to 96
adding to Instant Palm Desktop 153
See also pop-up menus 153

Merging user data files 141
migrating from Claris Organizer 107
mini-address book 123
Modem HotSync 142
modems 57
Month view 4, 61

N
names and addresses. See addresses
notes

printing 136
sorting 89

O
ongoing events 62
ongoing tasks See To Do List, repeating 
items 76
opening files 7
opening Palm Desktop software 6
options, default 12

P
Palm Desktop software

opening 6
quitting 8
tutorial 17

paper clip pop-up menu 99
paper planners 117, 138
Personal LaserWriter 157
phones 54, 153
PICT files, printing fax sheet as 135
PIMs 108
pop-up menus

adding items to 46, 80, 97
preferences 12

Address Book 58
addresses 105
alarms 13, 67
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DeskWriter 156
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LaserWriter 156
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notes 136
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Personal LaserWriter 157
pre-punched forms 155
previewing 116
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priority of To Do List items 80

R
recently used items 95
reminders
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events 64, 67
for To Do List items 79
transferring to your handheld 66

renaming fields 47
reordering columns 90
rescheduling 64
resizing columns 90
return addresses

printing 127, 129, 133
revealing all items 88

S
salutations, letter 50
scheduling appointments 59
screen appearance

scripts 48
searching 87, 93, 114, 152
settings, default 12
showing all items 88
showing and hiding columns 90
size of text 13
sorting 89

To Do List items 82, 89
special dates. See events
states 46
synchronizing files 141

T
tasks. See To Do List 75
telephone numbers 46

auto-dialing 54, 153
automatic formatting 47
preferences 56

templates 8–10
text size 13
text, finding 87, 94
things to do. See To Do List
time of events 64
time, seeing current 60
timestamp button 5
To Do List 75–84

application on your handheld 82
categorizing items 80, 96
changing 78
completed items 81
deleting items 82
hiding items in Date Book 61
moving items 81
preferences 84
prioritizing items 80
repeating items 76
selecting items 114
showing all items 88
sorting 82, 89
transferring to your handheld 82
unscheduled items 76
viewing 78, 86, 90
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tutorial 17
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V
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